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INTRODUCTION 
 
Thank you for purchasing the Automated District Management System (ADMS). ADMS is a 
comprehensive software system designed specifically to help BSA district leaders better manage the 
units and adult leaders in their districts. ADMS tracks district and unit-level adult leaders, including 
personal data, leadership positions, leadership history, training, special awards, and Order of the Arrow 
(O/A). ADMS also tracks training schedules and district-level activities (e.g., Roundtables, Pow Wows, 
etc.), including attendance. For each unit, ADMS tracks address, phone numbers, meeting location, adult 
leaders, chartered organization, chartering status/history, membership figures, popcorn sales, Friends of 
Scouting, participation at district events, and visitations.  In addition, the advancement progress of 
scouts in each unit is tracked and summarized. 
 
ADMS will also help manage the district’s merit badge counselors, including badges taught and whether 
or not they are willing to teach outside of their associated Boy Scout troops. A “Friends of Scouting” 
(FOS) area is provided so you can track major donors, businesses, associates, etc., who contribute to 
Scouting outside of the annual unit/family FOS drive. There is also a “points of contact” (POCs) area in 
case there are any other people associated with your district who sometimes need to be contacted. 
Of course, ADMS produces a wide range of reports on all of this data. 
 
To get the most from your new software, we recommend the following:  
 

(1) Read this User’s Manual. It is especially important that you read Chapters 2, 3, 5, 6, and 
10. We also recommend that you pay special attention to the items that are highlighted.  
This manual uses the following conventions: 

 
Information that is critical to utilizing ADMS is displayed as bold, red text within a 
shaded box. 

 
Information that requires special emphasis is displayed as black text within a shaded box. 

 
Helpful hints for getting the most out of your system are displayed in green text next to a 
light bulb icon. 

 
(2) Backup your data. Don't let a hardware failure force you to start over. See Chapter 14 for 

recommended procedures.  
 
You are now ready to get started. If we have achieved our goal, you soon will be spending less time with 
paperwork and more time with the adult leaders and scouts who need you! Happy Scouting! 
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CHAPTER 1. INSTALLATION 
 
1.0 Overview 
 

The program CD in your package contains the ADMS setup program. SETUP will create the 
necessary folders, install the software and a PDF copy of the Users Manual, and create an empty 
database.  

 
You will need the following: 

 
(1) A 486 processor or higher with a minimum of 16 MB of RAM. 
 
(2) A hard disk drive with at least 20 MB of available disk space. If you also need to install 

Adobe® Acrobat® Reader 5.0, an additional 20 MB will be needed. 
 
(3) Windows 95/98/ME/2000/NT/XP or newer. 
 
(4) A printer supported by Windows. 

 
1.1 Registering Your Software 
 

Your software was registered at the time of purchase. If the point of contact changes, please 
contact Troopmaster Software and provide the name, address, phone number, and email 
address of the new contact. This can be accomplished by phone or email.  
 

1.2 Installing ADMS 
 

SETUP will ask you to specify folders for your new software and data files. We recommend 
using the default folders but you can modify those, if desired.  

 
We do not recommend using a removable media (e.g., zip drive) as the primary location for 
your data files. Removable media are not nearly as reliable as a hard drive. 
 
To install ADMS, insert the program CD into your CD-ROM drive. The installation menu 
program should launch automatically. If it does not, follow the steps below: 

 
(1) Click the Start button and then select “Run”. 
 
(2) Click Browse and navigate to the SETUP.EXE file on the CD-ROM drive. 
 
(3) Click Open. 
 
(4) In the Run dialog box, click OK. 

 
Follow the instructions provided on the screen. When the installation is complete, remove the 
CD and store it in a safe place. 
 



 8

The full Users Manual will be installed on your computer in PDF format. You must have 
Adobe Acrobat Reader 4.0 or newer installed on your computer in order to view the manual. 
In case you don’t have Acrobat Reader, SETUP will offer to install a copy. 

 
1.3 Starting ADMS 
 

If you created a desktop icon during the installation, double-click that. Otherwise, click the 
Start button and select “Programs”. Highlight the Automated District Management System 
folder and click the ADMS icon. 
 
You don’t have to start with an empty database—please read Appendix D for a 
recommended approach for importing data from ScoutNET and other sources. 

 
1.4 Reinstalling ADMS 
 

If you previously installed ADMS and need to reinstall it or if you want to install it on a 
second computer, you’ll need a backup of the district data files. This can be obtained using 
the File>Backup Data Files option. If you also want to load the archived data, you’ll need to 
perform a separate backup of the archive files. 
 
Run the installation as described above. When the installation is complete, start ADMS and 
select the File>Restore Data Files option. The active district data and/or archived data can 
then be restored. 

 
1.5 Updating ADMS 
 

We occasionally make minor changes to the software and produce a program update (e.g., 
V1.01, V1.02, etc.). When we do, we post a free program update patch at the bottom of the 
ADMS product page on our web site. To see if you need an update, select the Help>About 
option to see which version of the software you are currently running. Then, click the “Check 
for newer version” hyperlink at the bottom of the dialog, which will take you directly to the 
latest patch on our web site. Compare the version you have to the version of the patch. If 
your version is older, please download and install the update patch or (better) run the patch 
directly from our web site. If you download the patch, please do not save it to the main 
ADMS program folder because it’s very easy to accidentally overwrite the program with the 
patch. For guidance on downloading and installing a patch, please see the FAQs page on our 
web site. 

 
You must close ADMS before running an update patch. The patch cannot update the 
program while it is running. 

 
 

http://www.troopmaster.com/faq/faq_misc.html
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CHAPTER 2. USING ADMS 
 
2.0 Overview 
 

This chapter covers the “basics” you need to operate your new district management system. 
ADMS is intuitive and very easy to use. However, reading this chapter first will get you 
started on the right foot. We also encourage you to read Appendix D, which explains how a 
great deal of the data you need can be imported. 

 
2.1 Main Menu 
 

There are ten main options on the Main Menu: File, Activities, Adults, District, Friends of 
Scouting (FOS), Merit Badge Counselors (MBCs), Points of Contact (POCs), Reports, 
Training, and Units. There is a separate chapter in the Users Manual corresponding to each of 
these options.  

 
2.2 Tool Bar 
 

A tool bar is available to provide faster access to the most frequently used features in ADMS. 
The following list identifies each of the tool bar buttons from left to right along with the 
equivalent menu path. 

 
Button      Icon Description    Menu Equivalent 

 
   Backup     Diskettes with letter “B”  File>Backup Data Files 
 
   Restore     Diskettes with letter “R”  File>Restore Data Files 
 
   Notepad     Notepad and pencil   File>Notepad 
 
   Email      Earth and envelope   File>Send Email Message 
 
   Calendar     Desk reference calendar  File>Calendar 
 
   Activity Management  Round Table     Activities>Activity Management 
 

Friends of Scouting  Fleur-de-lis         FOS>FOS Management 
 
Training     Man with chart    Training>Training Management 
 
Adult Management  Man’s face      Adults>Adult Management 

 
   MBC Management  Citizenship in Nation MB  Counselors>MBC Management 
 
   POC Management   Rolodex      POCs>POC Management 
 
   Unit Management   Cub Pack Flag     Units>Unit Management 
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2.3 Backups 
 

Backing up your district data is extremely important because this data represents a major 
investment of your time. Don't let a hard drive failure force you to reenter everything from 
scratch. Please see Chapter 14 for recommended procedures.  

 
The File>Backup Data Files option in conjunction with the File>Restore Data Files 
option can be used to transfer the district database and/or archive files from one 
computer to another. However, all of the district’s data on the target machine will be 
overwritten by the data restore option. There is no way to merge two district databases. 

 
2.4 System Date 
 

ADMS gets the date from your system clock and uses it extensively throughout the program. 
Please ensure your system date is correct before starting the program. 

 
2.5 Data Entry Dialogs 
 

The cursor can be positioned to or within any data entry field with your mouse. Press TAB to 
move to the next data entry field or Shift-TAB to move to the previous field. Pressing 
ENTER activates the highlighted button. 

 
Please do not make data entries with Caps Lock on. Doing so makes it very difficult for 
ADMS to fit your entries on displays and reports. Even worse, it is inconsistent with the way 
data is stored in ScoutNET. 

 
To facilitate collecting data on your adult leaders, merit badge counselors, friends of 
scouting, and other points of contact, several data collection forms are available. Copies of 
these can be printed through the Reports>Forms option. 

 
The File>Preferences option has fields for you to enter the city, state, zip code, and area 
code common to most of your adults. Your entries here will be used as the defaults whenever 
you add a new adult to the database. 

 
Most items on the various data entry dialogs are self-explanatory. For others, holding the 
mouse pointer over the field label will display an expanded description. 

 
2.6 Entering Dates  
 

Dates can be entered in a variety of formats using slashes, dashes, or periods as separators or 
by typing a six-digit date with no separators. The following entries are equivalent: 09/06/04, 
9/6/04, 9.6.04, 9-6-04 and 090604. If you omit the year (e.g., 9/6), ADMS automatically 
appends the current year. Please do not enter 4-digit years. ADMS internally appends the 
century based on context logic. 
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You can also make shortcut date entries by typing a single character in the first position of 
the date field: 
 
a. Same Date. Enter an L or S. ADMS will repeat the last date entered. 
 
b. Today's Date. Enter a T. This option is available in all date fields. 

 
There is also a pop-up menu to assist you in date entry. Simply right-click the date field and 
you can then choose to copy/paste a date or to select a specific date from a pop-up calendar. 

 
2.7 Modifying Date Entries 
 

To change the completion date on an award or training course that has been added to a list 
box, double-click the entry and enter the new date in the pop-up window. 

 
2.8 Saving Changes 
 

Clicking the OK button always saves data entries. Click Cancel to exit a data entry dialog 
without saving your changes. 

 
2.9 List Box Selection  
 

a. Single Selection. In addition to highlighting the desired item and clicking OK or Select, 
single-selection list boxes allow you to simply double-click the item. Double-clicking 
will immediately execute the request unless additional information is needed.  

 
b. Multiple Selection. Some (but not all) list boxes allow you to make multiple selections. 

For example, when crediting a group of adults for a training course, you can select 
multiple names from the list of adults. To select more than one item from a list box, hold 
the CTRL key down while you click the desired items with the mouse. To select a 
contiguous group of items, click on the first item desired; then, hold the SHIFT key down 
and click the last desired item in the group.  

 
You can distinguish multiple selection list boxes by the field label. For example, if more than 
one activity type can be selected, the label will say, “Select type(s)”. 

 
One way to move quickly to the desired point in a long list of entries is to move the focus to 
the list box and then start typing the name of the desired item. For example, typing a W while 
the focus is on a list of names will take you to members whose names start with “W”. 

 
2.10 Filtered Selections 
 

The software recognizes that your database can get quite large. In order to help you manage 
large numbers of adults, merit badge counselors, etc., ADMS provides a “Filtered Selection” 
option on displays and reports. For example, on the Adult Management dialog, the “Display” 
drop-down box lets you control which leaders are displayed on the selection list. In addition 
to being able to limit the selection list to a specific unit type (Troop Leaders, Pack Leaders, 
etc.), you can also choose the “Filtered Selection” option. Choosing this option displays a 
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dialog that provides very flexible selection criteria. For example, using this dialog, you could 
limit the display list to, say, just cubmasters and scoutmasters. You can select any 
combination of the available filter options. 
 
There’s a filtered selection dialog available for adult leaders, friends of scouting (FOS), merit 
badges counselors (MBCs), points of contact (POCs), and units. A specific description for 
using each of these dialogs follows. 
 
a.  Adults. The filter dialog allows you to select one or more leadership positions, employer 

name, unit type, or a specific unit. If you have defined categories (see para. 5.3) and 
assigned adults to them, you can select a specific category. An “O/A Members Only” 
checkbox allows you to generate a list or a report of just your O/A members. Click the 
Select Member Groups button to select one or more groups created through the 
District>Group Members option (see para. 4.3a). You can even use the filter to search 
for specific text within the “Remarks” fields on your adult leaders’ personal data dialogs.  

 
Click Reset Filter to clear all of your selections. Uncheck the “Activate Filter” checkbox 
to turn the filter off. 

 
b.  Friends of Scouting.  The filter dialog allows you to list friends assigned to one or 

more of your defined campaigns and/or those with a specific employer name.  
 

The “Donation History” block allows you to find friends who have not donated since a 
date you specify. Alternatively, you could search for friends who have contributed at 
least once since a date you specify and/or have contributed at least a specified amount. 
 
Click the Select Member Groups button to select one or more groups created through 
the District>Group Members option (see para. 4.3a). You can even use the filter to 
search for specific text within the “Remarks” fields of your friends’ personal data.  
 
Click Reset Filter to clear all of your selections. Uncheck the “Activate Filter” checkbox 
to turn the filter off. 

 
c.  Merit Badge Counselors.  The filter dialog provides a wide range of options, 

including limiting the list to counselors who teach a specific badge and/or are assigned to 
a specific area (see para. 7.3).  

 
If you select counselors affiliated with a specific unit, you can also elect to include 
counselors with other units who are willing to teach outside of their affiliated units. This 
would allow you to build a report for a specific troop that lists all counselors available to 
that troop. 
 
The “Zip Code” field helps you find counselors within a full or partial zip code. For 
example, an entry of “229” would retrieve counselors in zip codes 22901 through 22999. 
On most reports, you’ll probably want to exclude counselors who don’t teach outside of 
their respective units, but an “Include” checkbox enables to include them when you wish.  
 
The “Certification” block lets you retrieve counselors whose “Recertification” date falls 
within a specific from-to period. Entering a “From” date without a “To” retrieves all 
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counselors certified on or since that date, while entering a “To” date without a “From” 
retrieves all counselors last certified on or earlier than that date. You’ll rarely want to list 
counselors who have no certification date, but a checkbox allows you to do that, when 
needed. The “Last Taught” block lets you retrieve counselors who have taught a badge 
since a date you specify or those who have not taught since that date. 

 
You could use the certification “To” option when generating personal data reports, mailing 
labels, envelopes, or email messages for counselors who need to be recertified. 

 
Click the Select Member Groups button to select one or more groups created through 
the District>Group Members option (see para. 4.3a). You can even use the filter to 
search for specific text within the “Remarks” fields of your counselors’ personal data.  

    
Click Reset Filter to clear all of your selections. Uncheck the “Activate Filter” checkbox 
to turn the filter off. 

 
d.  Points of Contact.  If you have defined categories (see para. 8.2) and assigned POCs 

to them, you can select one or more categories. The “Skills/Interests” block lets you 
retrieve POCs who match any or all of the specified entries. Click the Select Member 
Groups button to select one or more groups created through the District>Group 
Members option (see para. 4.3a). You can even use the filter to search for specific text 
within the “Remarks” fields on your POCs’ personal data dialogs. Click Reset Filter to 
clear all of your selections. Uncheck the “Activate Filter” checkbox to turn the filter off. 

 
e.  Units.  The filter dialog allows you to select one or more unit types. The “Select Unit 

Commissioner” box lets you limit the report to units assigned to a selected commissioner. 
Checkboxes allow you to limit the report to LDS units and/or special needs units. You 
can also use the filter to search for specific text within the unit “Remarks” fields.  

 
Click Reset Filter to clear all of your selections. Uncheck the “Activate Filter” checkbox 
to turn the filter off. 

 
2.11 Quick Access Buttons 
 

Numerous dialogs include quick access buttons that enable you to move quickly to related 
dialogs. For example, when on an adult’s personal data dialog, quick access buttons let you 
to jump to the adult’s training, awards, leadership, or OA dialogs. 

 
2.12 Data Protection and Privacy 
 

Whenever you use ADMS to backup your data (para. 3.1), email your data (para. 3.4), or 
upload your data to an FTP site via the DotNet add-on (para. 3.10), the data is compressed 
into a small backup file. While the compressed file is always encrypted after being created, 
anyone who gains access to one of the files and has a copy of ADMS can decrypt and 
decompress the file unless you define an encryption password. Therefore, we strongly 
encourage you to create a unique Data Encryption Password for your district (para. 3.11).  
Once you have created a password, no one can decrypt or decompress your backup files 
without having this password.  
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CHAPTER 3. FILE 
 
3.0 Overview 
 

This menu provides a group of miscellaneous utilities. It includes such things as file 
backup/restore, data import/export, database management, and archive access. 

 
3.1 Backup Data Files  
 

This option allows you to backup your active database and/or your archived data. Select the 
file type to backup and then enter a backup location. You can backup to diskette, to a zip 
cartridge, a formatted CD, or to another directory on your hard drive. Either enter a 
destination path or use the Browse button to select a backup location. 

 
ADMS will compress your data files into a single, relatively small backup file. However, 
unless you have a small district, the backup file may be too large to fit on a diskette. If not, 
you will need to use a larger medium, such as a zip cartridge. 

 
If you plan to backup to a CD, you must format it first. CDs do not come pre-formatted but 
your CD drive would have come with a program that includes a format utility. 

 
Backing up your data is extremely important. For recommended procedures, please see 
Chapter 14. 

 
3.2 Open Archive Files  
 

To review your archive or to print a report on an adult who has been archived, select this 
option. Since it’s possible to have more than one archive, ADMS will ask you to specify the 
path to your current archive. The default path will automatically display the last archive used. 
When you click OK, ADMS will load your archived files and change the window title to 
remind you that you are in the archive. Options not available in the archive (e.g., Training) 
are deactivated. See Chapter 13 for more information on using the archive. 
 
The menu option name will change to “Open Active Data.” When you have finished 
reviewing your archive, select this option to switch back to your active database. 

 
3.3 Restore Data Files  
 

This option enables you to restore data from a backup made through the data backup feature 
(see para. 3.1). It will also restore data from a manual backup if all of the data files are on 
one storage medium. If you want to restore a backup of your archive, you must open the 
archive first (see para. 3.2), and then select the File > Restore Data option. If restoring from 
a manual backup (i.e., the backup was not made from within ADMS), please turn off the 
“Decompress files” checkbox. 
 
Check “Restore text files” to restore any Notepad files that are on the backup.  
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“Restoring” data is a critical operation. If the backup medium is damaged, that damage 
could be transferred to the files on your hard drive, making those unusable. That’s one 
reason that it’s important for you to maintain more than one data backup. 

 
3.4 Email Data Files  
 

If more than one district leader is using the software, you will need to periodically provide 
database updates to the other leaders. The File>Email Data Files option makes it easy to 
email the files so that you don’t need to hand deliver them. Simply select the desired 
recipient(s) and click Send. 
 
ADMS will compress your database into a single, small backup file, attach that to the 
message, and post the message in your email system’s “Outbox”. The recipient will need to 
save the message attachment to a diskette or hard drive folder, and then load the backed up 
files via the File>Restore Data Files option. 

 
3.5 Send Email Message  
 

There are many ways to initiate email from within ADMS. For example, you can select this 
menu option, click the email tool bar button, or you can choose to email a report.  

 
You then need to select the desired recipient(s) for your message. First, click the “Display” 
drop-down list to choose the desired group (i.e., adults, MBCs, troops, etc.) From each group, 
highlight the recipient names and then click To or CC to add the selected names to the 
primary addressee (i.e., “To”) list or the carbon copy (“CC”) or blind carbon copy (“BCC”) 
list. You can select names from as many of the different groups as you like. If you need to 
email someone who is not in the database, enter that email address in the “Other” field. To 
remove a recipient that was added in error, highlight the name and click Remove. 

 
Radio buttons beneath the “Recipients” list allows you to switch from “CC” to “BCC”. To 
hide email addresses from a block of recipients, you should select the “BCC” option unless 
your email program doesn’t support BCC. 

 
Enter the subject of your message in the field provided. ADMS provides a limited “Body” 
field where you can enter text for your message. However, your email system provides a 
much larger text field as well as extensive editing and formatting options. To take advantage 
of those features, click the “Display message prior to sending” checkbox. Then, when you 
click Send, ADMS will activate your email system, which will display your new message. 
This gives you a chance to refine your message before it is transmitted. 

 
Use of the email features in ADMS requires a MAPI compliant email system that uses the 
SMTP protocol. Unfortunately, AOL doesn’t meet either of these criteria. 

 
 

Some email systems have a security feature that warns you if another program (such as 
ADMS) adds a message to your “Outbox”. You may get this warning if you did not check the 
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“Display message prior to sending” checkbox. Some of these email programs will allow you 
to turn these warnings off. 

 
You can also send an email message to an individual recipient by clicking the “Email” button 
next to the member’s email address on his/her personal data dialog. 
 
a.  Save Recipient Group. Often, there is a specific group of people to whom you send 

messages on a regular basis. This option makes it easy to create as many different groups 
as you need. To save a selected group of recipients for use again later, add all of the 
desired names to the “To” and “CC” lists, and then click the Save Recipient Group 
button. Next, enter a unique group name and click OK. Recipient groups that you have 
defined are available through the “Display” drop-down list. To delete a recipient group, 
select it from the drop-down list and click the Delete Recipient Group button. 

 
b.  Email Options. If you are having difficulty sending email through ADMS, clicking this 

button provides some options that may help.  
 
 (1) Build Message Using – If your email system cannot handle names and email 

addresses, select the “Email address only” option. 
 
 (2) Retain Email Session – If the first message you send after starting ADMS works but 

subsequent messages fail, checking this box usually corrects the problem. 
 
 (3) Omit ‘SMTP” – ADMS usually prefixes each email address with “SMTP:” although 

this is generally hidden from the user.  If you can see this prefix and it’s causing error 
messages within your email system, checking this box will correct the problem.  

 
3.6 Exporting Data  
 

Many people like to design custom reports or to use their data for other purposes. For 
example, having access to the adult leaders' names and addresses could allow you to create 
mail/merge documents with your word processor. 

 
To facilitate that, ADMS allows you to export data from several areas of the database. The 
data is written to delimited ASCII files using any delimiter you choose. Most of the time, you 
will want to import the data into a database management system or spreadsheet so that you 
can manipulate the data, design reports, etc. 
 
The default delimiter is a comma but you can change that to any character desired. To create 
TAB delimited files, enter T. If you would like to have the names of the data items you select 
to appear in the first line of the export file, check the associated checkbox. If you will be 
exporting dates, select the desired format.  
 
Then, select the area (e.g., adults, MBCs, POCs, etc.) of the database from which you want to 
export data. ADMS will display a list of data items from that area in the “Available Fields” 
list box. You can then select the specific data items you want and add them to the “Fields to 
Export” list box. To do that, highlight the desired fields and click Add. If you want all of the 
data items, click Add All. To remove an item that was added in error, highlight the item and 
click Remove.  
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When you have finished selecting all of the desired data items, review the order of the items 
in the “Fields to Export” list. This is the sequence order in which these fields will appear in 
the export file. If you need to change the sequence, highlight the field that needs to be 
relocated and click the Move Up or Move Down button. 
 
When exporting adult leaders or other members, you can optionally limit the members 
included in the export file based on selection criteria. For example, adult leaders could be 
limited to specific unit types or by “Filtered Selection” (see para. 2.10a). 

 
Once you have selected the export type, fields to export, and members to include, you are 
ready to create the export file. If you wish to view and/or print a copy of the file format, click 
the View Export File button. When finished, click the Export button. ADMS will display a 
Save As dialog that allows you name the file and select the target folder. 

 
3.7 Importing Data 
 

To facilitate building your database, ADMS provides several import options. For example, 
you can import from an ASCII delimited file or from a ScoutNET unit export file. The 
options in this area are “one-time” functions designed to help you get started. ADMS also 
provides “routine” import options for receiving periodic updates of your database. On the 
Counselors pull-down menu, there are “Receive” and “Transfer” options that allow you to 
send/receive data to/from the district leader who is responsible for maintaining the MBC 
database. In addition, on the Unit Management dialog, there’s an Import button (see para. 
11.1c) for loading revised data from units using TroopMaster and PackMaster. 

 
a. ASCII Delimited.  This option makes it possible to import data that you were 

maintaining on some other database system. You’ll need to export the data from the other 
system to an ASCII delimited text file using any delimiter you like.  

 
We recommend that you first create an import format structure in ADMS and then use 
that format when creating the export file from your other program. First, select the type 
of data you plan to import from the “Select area” drop-down list. Then, highlight the 
desired data items and click Add. If you add a field by mistake, highlight it and click 
remove. If necessary, adjust the data item sequence by highlighting the item that need to 
be moved and click the Move Up or Move Down button. When finished, click the View 
Import Format button and print a copy of the file format. Use this along with the 
delimiter you selected to create your import file. 
 
When you have the file, return to this dialog, recreate the same import structure, and click 
Continue. Lastly, browse to the import file and click Open to begin the import process. 

 
The ASCII import options are all one-time operations. When you import data on adult 
leaders, MBCs, POCs, or FOS, the members being imported will replace any members 
of the same type who are already in the database. For example, if you import adult 
leaders, ADMS will erase any existing adult leaders from the database before it 
processes the import file. 
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b. Counselors. This option lets you import MBCs from two other TroopMaster 
Software programs: MBCounselors and TroopMaster (Millennium version or newer).  

 
(1) MBCounselors. ADMS can import counselors directly from a backup of the 

MBCounselors database. Optionally, you can add the new counselors to your 
existing database or replace existing counselors with the ones in the backup files. 

 
(2) TroopMaster. ADMS can import counselors from a transfer file created by 

TroopMaster Millennium (or newer). The TroopMaster must create this file through 
the File>Export>District Program Files>MB Counselors menu option. Counselors 
in the transfer file (“Troop xxx Transfer.xfr”) will be added to the existing database. 

 
You cannot import data directly from a backup of the TroopMaster database. 

 
If case you want to designate a separate district leader to track merit badge counselors, 
ADMS provides any easy method of transferring just the counselor portion of the district 
database between ADMS users. Please see Chapter 7. 

  
c. ScoutNET. There are two main ScoutNET import options. 
 

(1) Leaders/Scouts  – Single Unit.  ADMS can import scout and adult personal data 
from a unit export file created by your local council using the BSA ScoutNET 
computer system. Council personnel procedures for creating the file are as follows: 

 
a) From the ScoutNET main menu, select the "Unit Menu". 
b) Do a unit search. 
c) Insert a diskette and click the "Export" button.  
d) Go to the print queue screen and select "Save to disk". 
e) Lastly, select "Save all files" (not "Save print files"). 

  
If that's done correctly, the name of the file they'll give you is "LODxxxxx.CSV", 
where xxxxx denotes your unit type and number. When you have the file, bring up 
this import dialog and select the appropriate unit. If the desired unit is not listed, click 
the Add New Unit button and enter the basic information on the new unit. After 
selecting the desired unit, click Continue and then browse to the export file. 

 
This procedure will add new adults with that unit to your database and update data on 
existing adults (based on a name/unit match). However, any scouts with that unit in 
your existing database will be erased and replaced with the ones from the ScoutNET 
file. You cannot use this procedure to update data on existing scouts. As of this 
writing, only a limited amount of personal data is imported. The ScoutNET file does 
not contain training or advancement data. 

 
(2) Leaders/Training – All Units. This option will import the basic personal data, 

unit affiliations, leadership positions, and training status information for unit leaders 
in your district. In order to import all of the registered leaders in your district, you 
need to obtain two report files from your council: “Training Completed” and 
“Training Not Completed”. You then perform a separate import for each of the files.  
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The import process will not only add new adults to your database but it will also 
update the data on existing adults. Therefore, you’ll want to repeat this import process 
periodically in order to keep your database in synch with your council’s ScoutNET 
system. If this is the first time you’ve imported these files and the files are large, the 
import process can take 30 minutes or longer. Subsequent imports are much faster. 

 
Council personnel procedures for creating the files are as follows: 

  
1) From the "Membership" menu, select "Membership Reports." 
2) Select "Advancement and Training."  
3) Select either the "Training Completed" or the "Training Not Completed" report.  
4) On the “Pgm Units” tab, select the desired district. 
5) On the "Stop Level" tab, select "District."  
6) On the "Other" tab, select "Create a File". This tab is usually off the screen--

you will have to click a drop-down button to select the "Other" tab from a list. 
7) Click the "File" button and the export file will be sent to the reports depository. 
The file should be a tab-delimited text file, not comma separated variable (CSV). 
  
The export files do not contain all of the training courses for each leader but only 
those courses required to reach the “Trained” status for his/her position. 

 
If you choose to import merit badge counselors, any counselors in the file will be added to 
your counselor database. This process will not update data on existing counselors. 
 

3.8 Calendar  
 

This provides the electronic equivalent of a desk calendar. You can access it through the 
menu option or the tool bar button, and you can display anywhere from one to 12 months at a 
time. Use the arrow buttons to view future or past time periods. This calendar is not related to 
your district activities calendar, which is generated through the Reports>Activities menu. 

 
3.9 Notepad  
 

Often you need to make notes of “things to do” or for many other purposes. This option 
provides rapid access to the Windows Notepad. A “District Notes” file has already been 
created for you. You can use that or you can create as many others as you like. Notes you 
create can be edited and printed.  

 
3.10 ADMS DotNet  
 

ADMS DotNet is an add-on feature that enables you to maintain a centralized database on an 
FTP site. This allows multiple leaders to access and update the database without having to 
rely on operational controls. DotNet is not a standard part of the ADMS program so it must 
be purchased separately.  DotNet comes with an FTP site provided by Troopmaster Software. 
To enhance security, the address of our FTP server is not released nor are the actual user ID’s 
and passwords needed to log in. Access to your FTP site is redirected and processed 
internally by the software. 
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You’re not required to use the FTP site on our server but if you choose to use a different 
server, user support will be limited.  
 
The DotNet interface is controlled through a dialog on the “File” menu. When you initialize 
your web database, ADMS compresses the data files from your hard drive into a much 
smaller file (ADMSData.bak) and uploads that to your FTP site.  Thereafter, whenever you 
open the program, ADMS will automatically download the database backup, de-compress the 
files, and save them to the DATA folder on your local hard drive.  While you are working in 
ADMS, you will be working with this local copy of your database so you will not experience 
any Internet delays in program response times.  In fact, you can even disconnect from the 
Internet until you exit the program. 
 
When you exit ADMS, the data files will again be compressed and uploaded to your FTP site 
so the next person to log on will have access to the most current data. If you disconnected 
from the Internet after starting ADMS, you must re-connect before exiting. 
 
a. Procedures.  Select the File > ADMS DotNet menu option.  Then, check the “Activate 

ADMS DotNet” checkbox and enter the server, user ID, and FTP password needed to 
access your FTP site. Please remember that your user ID and password are case-sensitive. 
We recommend that you use the default port (21) but you can change that if you like. 
 
Next, enter the path on your FTP site where the data will be stored (e.g., /data). If you’re 
using our server, the web data path is a forward slash (/). By default, TroopMaster uses 
“Passive” mode transfers, and this mode is required by most firewalls. If you want the 
FTP site to establish the data connection to your PC, uncheck this box. 
 
While the compressed database file is always encrypted before being uploaded to the FTP 
site, anyone who gains access to the file and has a current copy of ADMS can decrypt 
and decompress the file unless you define a unique encryption password for your district. 
To do that, click the Data Encryption Password button (para. 3.11). 

 
Troopmaster Software strongly encourages you to create an encryption password. Once 
you do that, no one without that password can view any of the data from the web 
database or from a database backup file, no matter how they obtain a copy of the file. 

 
Occasionally, someone may want to log on without locking the database against updates 
by other users; e.g., just to print a report. To accommodate that, there is a “Prompt for 
read-only” option on startup. If you take this option, you will be able to view any part of 
the database without locking out other DotNet users. 

 
You can bypass the DotNet logon entirely by holding down the left SHIFT key when you 
click the program icon. This will load data from your local hard drive instead of downloading 
the web database. This option is useful if you need data quickly or if the web database 
becomes damaged. However, data changes you make will not be uploaded when you exit.  

 
There may be times when you’ll want to exit the program without unlocking the web 
database.  If so, select the “Prompt to upload/unlock database on exit” option.  For 
example, if you’d like to take data to meetings on a laptop computer and make updates, 
leave the web database locked until you come back home and upload your changes.  This 
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not only prevents other users from making changes while you are gone, it allows you to 
log back on later without overwriting your changes with the older data from the FTP site. 

 
Each DotNet user enters his name, phone number and email address in the fields 
provided.  This information is used to let other unit leaders know who is updating the 
data in the event that they try to log on at the same time. 

 
The Initialize Database button is normally used only by the database administrator to 
post the district database to your FTP site for the first time, but it can be used again in the 
event the web database gets damaged or if you just want to replace the database for some 
reason. Your database is automatically saved to your FTP site each time you exit the 
program, so you should not execute this option on a regular basis. 

 
The Unlock Database button is available as an override option in case a user either 
forgets to or for some reason cannot unlock the FTP database normally. 
 
ADMS keeps a log file of the last 20 users who have accessed the web database in 
“update” mode and the date/time they logged in. To review it, click View Log File.  
 

If your web database and/or the database “status” file become damaged, you can delete and 
replace the damaged files with data from your local hard drive by clicking the Initialize 
Database button. 

 
If the web database becomes damaged (which can happen if the upload process gets 
interrupted), it must be reinitialized. By viewing the log file, you can determine who last 
accessed the database. The web database should then be initialized from that leader’s 
computer, assuming that his database isn’t also damaged. We also recommend that each 
DotNet user routinely make a database backup when exiting ADMS. Doing that gives you 
another recovery option; i.e., you can compare the dates/times of the various backups and 
reinitialize using the most recent one.  

     
b. Restrictions. Once someone logs on in other than “read only” mode, the database is 

locked and all other unit leaders will be prevented from logging on to make changes. If 
you attempt to log on while the database is locked, you will see a message stating that the 
database is locked. The message will include the name of the leader using the files and 
the time that this leader logged on. At that point, you have the choice of either exiting the 
program or logging on in “read only” mode.  If you choose the “read only” option, you 
can view any of the dialogs and reports but you should not make any database changes. 

 
In “read only” mode, you are not prevented from making changes to the database but 
any changes you make will not be uploaded to the FTP site, so those changes will be 
overwritten the next time the web database is downloaded. 

 
There is a small time delay in sending the “locked” signal to your FTP site.  Although 
extremely unlikely, it is not completely impossible for two leaders to be logged on for update 
at the same time.  However, ADMS rechecks the locked status when you exit the program.  If 
someone else is logged on or was logged on and has since logged off, the problem will be 
brought to your attention at that time. 
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3.11 Set Encryption Password 
 

Whenever you use ADMS to backup your database (para. 3.1), email your database (para. 
3.4), or upload the database to an FTP site through DotNet (para. 3.10), your database is 
compressed into a much smaller backup file (ADMSData.bak). While the compressed file is 
always encrypted after being created, anyone who gains access to one of the files and has a 
copy of ADMS can decrypt and decompress the file unless you define an encryption 
password. Therefore, we strongly encourage you to create a unique Data Encryption 
Password for your district.   
 
To do that, enter a password on this dialog A good password should be at least eight 
characters long and should contain both letters and numbers. Once you have created this 
password, no one can decrypt or decompress your backup files without having this password. 
Please keep a copy of the password in a safe place. If you lose your password, Troopmaster 
Software can recover it but there is a service charge for doing that. To change the password, 
just enter a new one on this dialog.  

 
3.12 Create New Archive  
 

The archive created during program installation will store up to 10,000 adults and 5000 
MBCs. If that archive fills up, use this option to create a new archive.  

 
3.13 Preferences  
 

Use this dialog to adjust system-wide settings and to customize ADMS to your personal 
preferences. Most of your selections apply only to your computer; i.e., most preference 
settings are not part of a database backup. Exceptions are noted below. There are five tabs: 

 
a. Default Settings. This tab lets you set default values for city, state, zip code, area code, 

and phone types. Setting these values will save you time whenever you add new members 
to the system. If you are operating in a foreign country that does not use U.S. formatted 
zip codes and phone numbers, you should de-select the “U.S. phone/zip format” 
checkbox. ADMS processes overseas addresses, zip codes, and phone numbers 
differently than it does for stateside units. A list of countries and associated country codes 
is available through the Help button. All of these settings are included in a database 
backup. The rest of the settings on this tab are not. 

 
b. This tab also has several button and checkbox options: 
 

(1) Display ‘Tip of the Day’ on Startup. To stop seeing the tips, turn this off. 
 
(2) Enable Windows XP Themes. Check this box to turn on the dialog and control effects 

common to new XP programs. 
 
(3) Use Large Toolbar Buttons. This checkbox allows you to control the size of your 

toolbar buttons. 
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(4) Omit Completed MBs from Selection Lists. Check this box to omit merit badges a 
scout has completed from badge selection lists in the scout advancement area. 

 
(5) Prompt for Data Backup on Program Exit. Because backing up your database is so 

important, ADMS will offer to perform a backup each time you exit the program. 
This option turns the backup prompt off. 

 
(6) Save Location of Report Display Window. If this box is checked, ADMS remembers 

the size and location of the last report window displayed and uses those settings as 
defaults for the next report. If this box is unchecked, ADMS will bring up the report 
display window using the same location/size as the main application window. 

 
(7) Use Formal Name on Lists/Reports. Check this option if you want the program to use 

formal adult/scout names on displays and reports. 
 
(8) Include Area Code on Reports. If all of your members share the same area code, you 

may want to turn this option off. 
 
(9) U.S. Phone/Zip Format. If your district is outside of the U.S. but still uses U.S. 

formats, check this box. 
 
(10) System Password. Click this button if you want to password protect your system. 

Then, enter a password of 4-8 characters. You will be asked to reenter the password a 
second time to confirm your entry. The system password you create only applies to 
your computer. To clear a password, return the password creation dialog, leave both 
entries blank, and click OK.  

 
If you forget your password, please contact Troopmaster Software. 

 
(11) Reactivate System Messages. There are a number of pop-up information messages 

that you can selectively turn off so that they are not displayed again. Click this button 
to reactivate any messages that have been turned off. 

 
c. Background. This tab lets you adjust your main menu background colors. You can also 

replace our background scene bitmap, if desired. 
 
d. Page Settings. This tab lets you adjust margin settings for reports and labels. You can 

also modify the label settings to accommodate most label sizes. There is a Restore 
Defaults button in case you get yourself into trouble. If you want to increase the number 
of lines printed on each page, adjust the “Paper Saver” setting. In addition, there is a 
“Duplex Printing” option in case you want to print on both sides of the paper. ADMS can 
do this even if you don’t have a full duplex printer. 

 
e. Report Fonts. This tab lets you choose a font, style, point size, and color for each section 

of the reports. Just click the button for the section you wish to change. 
 
f. Protected Fields. This tab allows you to block the display of sensitive data, such as social 

security numbers, on dialogs and reports. You’ll need to define a “Privacy Password” to 
block other ADMS users from viewing sensitive data items on dialogs. 
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Any user, with or without the password, can turn on the privacy block for any of the 
fields listed in the “Report Settings” area. Report settings are not stored in the ADMS 
database; i.e., these settings are stored on and only affect the operation of the computer 
on which the settings are made. Any data item checked will cease to appear on reports 
generated on that computer. 
 
If you want to prevent certain ADMS users from seeing sensitive data items, enter a 
“Privacy Password.” You will be asked to reenter the password to confirm that you typed 
it correctly. Then, check the data items you want to protect. Any item you check will be 
automatically checked on the “Reports Settings” list also. Your selections will be stored 
in the ADMS database and therefore will affect the operation of the software on any 
computer that loads a copy of the database. If another user restores a copy of the 
database, none of the items checked on the “Protected Fields” list will be visible on 
displays or reports. 
 
If you want another ADMS user to have access to these data items, give that leader the 
privacy password. Any other leader who has the privacy password will have the same 
authorizations that you do.  
 
When ADMS is run on any computer that has a valid privacy password entered on this 
dialog, the protected fields will be visible on the displays but by default will not be 
included on reports. If a leader with the password wants to create some reports that 
include the protected fields, s/he should display this dialog, uncheck the desired data 
item(s) on the “Report Settings” list, and then generate the reports. However, any data 
item unchecked on the “Report Settings” list that remains checked on the “Protected 
Fields” list will revert to the previous setting (i.e., protected) as soon as you exit the 
program; i.e., those settings changes are treated by the system as temporary.. 
 
Any leader who has the privacy password can change the password just by entering a 
new one. Any other leader who subsequently loads a backup of that data must bring up 
this dialog and enter the new password in order to regain access to the protected fields. 
 

Please write down your password and keep that in a safe place. If you forget your password, 
contact Troopmaster Software. 

 
3.14 Repair Database  
 

You may never need this option but it is available, just in case. The option will rebuild your 
index files and examine your other data files. Missing records will be replaced with blank 
records. ADMS will report any errors it finds. However, the repairs that can be made are very 
limited. If a file has been overwritten by “garbage”, the repair process won’t be able to fix it. 

 
This is an emergency procedure. If your database is damaged, your best option is to 
restore your data from a good backup. Before running this option, backup your existing 
data in case the repair process fails. Do not overwrite any previous backups.  
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CHAPTER 4. DISTRICT 
 
4.0 Overview 
 

This area contains a group of district level functions, such as designating a mail recipient for 
the district, tracking district awards, validating Eagle candidates, etc. 

 
4.1 District General Information  
 

This dialog has fields for you to enter your council name and designated mail recipient. If 
your district has a website, enter the URL. Clicking the “Website” button will then take you 
directly to your site. 

 
4.2 District Awards  
 

This option lets you record awards the district has earned. For each award, enter an award 
name and completion date; then, click Add. To remove an award, highlight it and click 
Remove. 

 
4.3 Group Members  
 

The group members feature allows you to create member reports on subsets of your district 
database; i.e., instead of including all of your members. This allows you to choose which 
members you want to see on a report. This feature is very flexible because you can create and 
name as many member groups as desired. Adult leaders, FOS, MBCs, and/or POCs can be 
added to any group. 
 
All of the “Filtered Selection” dialogs in ADMS provide a “Select Member Groups” option 
that allows you to select one or more groups for inclusion on the reports. If you do that, only 
the members of the selected group(s) will be included. For example, you could create a group 
of your district committee members and then print a phone list or general purpose worksheet 
that includes only those members. Or you could create a group of FOS for a specific mailing 
and then generate mailing labels just for those friends.  

 
If you generate a report that is not applicable to certain members of a group, those members 
will not be included. For example, if you generate an adult leader phone list from a group 
that contains adults and POCs, the POCs would not be included. 

 
a. Create a New Group.  First, enter a “Description”. Then, highlight the desired names and 

click Add.  Use the “Display” drop-down list to adjust the list of names from which to 
select.  When finished, click the Save button and enter a name (e.g., “District 
Committee”) for the new group.  

 
 You can use an existing group as the starting point for creating a new group. Just select 

the existing group from the drop-down list, enter a new description, and then add or 
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delete names, as desired. When finished, click Save, and enter a new group name. Be 
sure to enter a new name or you will overwrite the existing group. 

 
b. Modify a Group. Select the desired group from the drop-down list and then add or delete 

names, as desired. When finished, click Save. 
 
c. Delete a Group. Select the desired group from the drop-down list and click Delete. 

 
You can print copies of the groups you’ve created through Reports>Other. 

 
4.4 Validate Eagle Candidate  
 

This option will help you validate an Eagle Application for a scout whether or not he is 
already in your database. ADMS will review his rank dates, merit badges, and Life rank 
leadership positions. It then will advise you whether or not the scout meets all of the 
requirements for Eagle; if not, it lists specific discrepancies. 
 
If the scout is already in your database, select the unit and scout from the respective drop-
down lists. If not, manually enter the unit and the scout’s name. 
 
If the scout is in the database, most of the data items will be transferred from his records. 
Using the scout’s Eagle Scout Application, manually enter any missing information (i.e., date 
of birth, rank dates, leadership positions, merit badges, and Eagle Project complete).  
 
To enter a merit badge, select the badge from the drop-down list, click Add, and enter the 
completion date in the pop-up window. To delete a badge, highlight the badge and click 
Remove. 
 
If you know the projected Eagle “Board of Review” date, enter that. Otherwise, use today’s 
date. If the scout is currently serving in a leadership position, enter the appropriate “From” 
date and use the projected “Board of Review” date as the “To” date. For some scouts, this is 
important because ADMS will use that date in determining whether or not the scout will have 
served the required six months in valid “Positions of Responsibility” by the date of his Eagle 
“Board of Review”. 
 
If desired, you can highlight (use CTRL-click) the 21 badges that the scout plans to apply 
toward his Eagle rank. Otherwise, ADMS will automatically choose the 21 badges based on 
dates earned and on the current Eagle-required merit badge rules. 
 
When all of the entries are complete, click Validate and ADMS will generate a validation 
report for the scout. If there are any requirements that the scout failed to meet, they will be 
annotated on the report. 
 
If you need to validate another scout, return to the validation dialog and click Reset.  
Otherwise, click Close to exit the dialog. If you made manual data entries for an existing 
scout, ADMS will offer to save those changes to the scout’s records. 
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CHAPTER 5. ADULTS 
 
5.0 Overview 
 

This area allows you to track adult members at both the district and unit level. The primary 
option is the Adult Management dialog, but other options allow you to define adult categories 
(used to group adults into committees, areas of involvement, etc.) or add to the system-
defined lists of leadership positions and special awards. There’s also a Group Credit function 
that makes it easy to credit an entire group of adults with a training course or special award. 

 
5.1 Adult Management   

 
The Adult Management dialog is your primary gateway to any area of your adult leaders’ 
records, although adults who are associated with units can also be accessed through the Unit 
Management dialog. In addition to an option to add new adults, you can edit/review data on 
any existing adult leader. Options include personal data, training, special awards, leadership, 
and O/A. The Add New and Personal Data buttons access the same tabbed dialog for data 
entry. Additional buttons allow you to access the other areas of each adult’s records. If you 
need to delete or archive an adult, click the Delete/Archive button. 
 

a. Personal Data. This dialog has three tabs. A brief description of each tab follows.  
 

(1) Personal Data #1. In addition to name, address and phone numbers, this tab has 
fields for date of birth (DOB) and BSA ID number (from the adult’s membership 
card). A box near the bottom of the tab lists the positions that have been assigned 
to this adult through the Leadership/Units dialog. If the adult is a district leader, 
check the associated checkbox.  If a district leader works for an assistant district 
commissioner (ADC), check that box also and select the appropriate ADC from 
the drop-down list. 

 
The adult’s nickname is normally used on all other displays and reports. If desired, you can 
elect to use formal name throughout the program--see the File>Preferences option.  

 
If all or most of your adults have the same area code, enter that on the Preferences dialog and 
ADMS will use it as the default for all phone number fields. 

 
To email an adult, just click the button next to his email address. 

 
(2) Personal Data #2. This tab has fields for social security number (SSN), 

employment information, and college/degree. If the adult is an Eagle Scout, check 
the box and enter the date he earned his Eagle. The “Categories” area lets you 
assign adults to pre-defined categories for increased flexibility when generating 
reports. For example, you could define a category for each district committee and 
then use this area to assign your adults to the appropriate committees. 

 
Collecting SSN’s raises Privacy Act issues. You should consult an attorney before doing 
this. 
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(3) Remarks/Other. This tab provides a place for you to enter information for which 

there are no system-defined data fields. In addition to a remarks field, there are 
eight user-defined fields: four text fields and four checkboxes. You can enter your 
own label for any of these fields by clicking the existing label and then entering a 
new label. For example, you might redefine one of the text field labels as 
“Hobbies” or use one of the checkboxes to indicate “Fees Paid”. Whatever field 
labels you enter for any adult will be used for all of your adults. ADMS has a 
special User-Defined Fields/Remarks report for these data fields. 

 
When you click OK, ADMS will save your entries. If you are in “Add” mode, ADMS 
will clear the display so that you can add another adult, if desired. Click Cancel when 
you are finished adding adults. 

 
If you are in “Edit/Review” mode, several additional buttons are available. Quick access 
buttons will take you directly to any adult’s awards, training, leadership and O/A dialogs. 
Previous and Next buttons allow you to “page” through your adults. 

 
To archive and/or delete an adult, click Delete/Archive. A pop-up dialog gives you the 
option of archiving (see para. 13.2) the adult before s/he is deleted. 

 
b. Special Awards. To credit an adult with an award, select from a menu of awards you 

defined on the Define Adult Special Awards dialog (see para. 5.5) or click Other and 
define a new award on the fly. Enter a completion date in the pop-up window. To 
modify the completion date of a previously credited award, double-click the award 
and enter a new date in the pop-up dialog. To delete an award that was entered in 
error, highlight the award and click Remove. 

 
c.  Leadership/Units. This dialog lets you record the adult’s leadership positions and the 

units, if any, with which the adult is serving in those positions. Any adult in the 
system can be assigned to up to six different positions/units. For district leaders, 
simply select the leadership position(s) without selecting any unit. ADMS uses the 
position “Start Date” when computing tenure and service starts. 

 
(1) Current Positions. To assign a leader to a position, select it from the drop-down 

menu of leadership positions. If the desired position is not on the menu, click the 
Define Positions button and add it. You can assign up to six current positions to 
each leader.  

 
To remove a leader from a previously entered position, select the blank position 
from the drop-down list and enter the date he vacated the previous position. 

  
When an adult changes leadership positions, the vacated position is automatically moved to 
the leadership history list. The “Start Date” of the new position, if any, is used as the close 
out date of the old position.  

 
(2) Leadership History. This area allows you to enter previous positions in which the 

adult served. To add a position to the list, select it from the drop-down menu, 
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enter the “From-To” dates, and click Add. To remove a position from the list, 
highlight the position and click Remove. 

 
d. Order of the Arrow (O/A). Click this button to enter or review O/A data on the 

selected adult. The data fields are self-explanatory. If an adult is under age 21, the 
“Recommended” field label changes to “Elected,” in accordance with O/A guidelines. 

 
e. Training. To credit an adult with training, either double-click the course name in the 

list box or highlight the course and click Add. Then, enter a completion date in the 
pop-up window. To modify the completion date of previously credited training, 
double-click the course and enter a new date in the pop-up window. To delete a 
course that was entered in error, highlight the course and click Remove. 

 
Adult training can also be credited from the Scheduled Course dialog (para. 10.1), the Group 
Credit dialog (see para. 5.2), and from each adult’s Partial Training dialog (see para. 5.1f). 

 
f. Partial Training. If a course has more than one session and the adult has not 

completed all sessions, you can record that information here. Partial training can also 
be credited through the Training Schedule dialog 

 
5.2 Group Credit  

 
This feature makes it easy to credit special awards or training completed by a group of adults 
at the same time. For example, if several of your adults complete Youth Protection Training, 
you can update their training records without having to retrieve each adult one at a time. If 
ADMS reports errors for an adult, you should retrieve that adult’s records and attempt to 
credit the item manually to see what the problem was. 
 

a. Special Awards. Select the desired award from the menu of awards you defined on 
the Define Adult Special Awards dialog, or type an award name in the “Other” field. 
Enter a completion date, select the desired adults, and then click Process. 

 
b.  Training. Select the desired course from the training menu you defined on the Define 

Adult Training dialog. Enter a completion date, select the desired adults, and then 
click Process. 

 
ADMS will credit a duplicate award or course as long as the completion date is different. 

 
5.3 Define Categories  

 
This dialog lets you define categories in which your adult leaders are involved. Having 
categories gives you increased flexibility when you generate reports. For example, you could 
define a category for each of your district committees or you could define more general areas 
in which your adult leaders are involved. To define a new category, just enter the category 
name and click Add. To change the spelling or wording of an existing entry, highlight the 
desired category and click Edit. To delete a category, highlight it and click Remove. 
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5.4 Define Leadership  
 

ADMS comes with a menu of standard adult leadership positions. Use this dialog to define 
additional ones, if needed. Your entries will appear on a positions menu that is presented 
whenever you assign a position to one of your adults. To define a new position, just enter the 
position name and a two-character position code; then, click Add. To modify an existing 
entry, highlight the desired position and click Edit. To delete a user-defined position, 
highlight it and click Remove. System-defined positions cannot be removed or modified. 

 
5.5 Define Special Awards  

 
Use this dialog to define the most common special awards presented by your district. Your 
entries will appear on an awards menu that is presented whenever you credit an adult with an 
award. However, you can credit awards that are not on the menu by using the “Other” option 
(see para. 5.1b). 
 

5.6 Retrieve from Archive  
 

If an adult you archived later returns to your district, you can retrieve his data through this 
option. After you specify a path to your archive, ADMS will present a list of archived adults 
from which to select. See paragraph 13.4 for more information on retrieving adults from the 
archive. 
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CHAPTER 6. FRIENDS OF SCOUTING  
 
6.0 Overview 
 

This area of the program gives you the tools you need to better mange your annual Friends of 
Scouting (FOS) campaign. It includes a dialog where you can define and monitor the various 
divisions of your campaign as well as a database for tracking friends who are not part of the 
family/unit campaign division. 

 
6.1 Campaign Information  
 

This dialog will help you establish the high-level management for your FOS campaign. The 
first tab lets you name each campaign division and specify a goal and kick-off date. You can 
also select a division representative from a drop-down list of district leaders. For each 
division, the “Amount Raised” figures will automatically be computed if you check the 
associated “Auto-Calculate” checkbox and there is associated data entered in the database. 
Otherwise, you can make manual entries. 

 
The “Family/Unit” division is pre-defined by the system and cannot be changed. If the 
associated “Auto-Calculate” box is checked, the donation total for this division is computed 
from figures entered in the “FOS Dollars” fields on the “History” tab of the individual Unit 
Details dialogs (see para. 11.1c(2)).  
 
You can define up to five other divisions, as needed. On each individual Friend of Scouting 
dialog, there is a field where you can designate which FOS division contacted the friend as 
well as fields to enter amounts each friend donated. If the associated “Auto-Calculate” box is 
checked, ADMS will use those fields to total the donations for each FOS division, and those 
totals will be displayed on this dialog. 
 
On tab one there is also a Setup FOS for 20xx button for use when you’re ready to start a 
new FOS campaign. Click this button to move the existing donation totals to the “Campaign 
History” tab and clear the figures on this tab. This action will also setup the new campaign 
year on the data entry dialogs for each of the friends in your database. 
 
The “Campaign History” tab lets you see the results for each campaign division for up to 10 
prior years. Because friends and units come and go, the figures on the “History” tab are not 
adjusted automatically if amounts for those years are changed on the friends or unit dialogs. 
However, you can adjust these amounts manually, if needed.  
 

6.2 FOS Management  
 

This dialog lets you track and manage individual “friends” who are not part of the 
“Family/Unit” campaign division. You can add or delete friends or edit/review data on 
existing friends. In addition to personal data, the individual Friends of Scouting dialog has a 
field for you to assign the friend to the appropriate campaign division as well as fields to 
track up to 10 years of donations. If the friend has been donating longer than that, enter the 
total amount for prior years in the “Prior Total” field. 
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When the 10 years are full and you need to create a new year, click the Setup for 20xx 
button. This will create a new year, delete the oldest year, and add the amount for that oldest 
year to the “Prior Total.” 

 
You don’t need to setup new years for your friends one-at-a-time. When you click the Setup 
for 20xx button on the Campaign Information dialog, ADMS will automatically setup the 
new campaign year on this dialog for each of the friends in your database 
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CHAPTER 7. MERIT BADGE COUNSELORS 
 
7.0 Overview 
 

This area allows you to track all of the merit badge counselors (MBCs) in your district. The 
primary option in this area is the Merit Badge Counselor Management dialog, but other 
options allow you to define counselor areas (e.g., geographic or badge types), to designate a 
primary district representative, to retrieve counselors from your archive, etc. There’s also a 
Group Update function that makes it easy to update counselor certification dates or credit a 
group of MBCs with training. Additionally, you can also add new merit badges as BSA 
releases them or adjust the Eagle-required badge list. 

 
7.1 MBC Management  
 

Use this dialog to add new counselors to your database and to edit/review data on existing 
counselors. The Add New and Edit/Review buttons access the same tabbed dialog for data 
entry. A brief description of each tab follows.  

 
a. Personal Data #1. In addition to name, address and phone numbers, this tab has a list 

box for badges taught. To assign a new badge, highlight the badge name and click 
Add. If you have defined “Areas” (see para. 7.3), you can assign the counselor to an 
appropriate area through the drop-down selection list. If the counselor is the area 
representative, check the associated checkbox.  

 
To assign a merit badge quickly, just double-click the badge name. 

 
To email an MBC, just click the button next to his email address. 

 
b. Personal Data #2. In addition to date of birth (DOB) and social security number 

(SSN), this tab has fields for original certification date, date the counselor was most 
recently certified, and the date s/he last taught a merit badge. There are also fields in 
which to record completion dates for training courses. 
 

Collecting SSN’s raises Privacy Act issues. Please consult an attorney before doing this. 
 

When you click OK, ADMS will save your entries. If you are in “Add” mode, ADMS 
will clear the display so that you can add another counselor, if desired. Click Cancel 
when you are finished. To remove a counselor, click Delete/Archive. A pop-up dialog 
gives you the option of archiving (see para. 13.2) the counselor before s/he is deleted. 

 
7.2 Group Update  

 
These five functions enable you to update the records of an entire group of counselors 
without having to retrieve each counselor one-at-a-time. In addition to being able to update 
“Recertification” and “Last Taught” dates, you can assign group credit to completion of 
Youth Protection and MBC Orientation training, and you can assign a merit badge to a group 
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of counselors. All five dialogs work exactly the same way: simply select the counselors to be 
credited, enter a date (or select a merit badge), and click Process. 
 

7.3 Area Assignments    
 

This option lets you easily set or change your area assignments. The “List currently displays” 
drop-down box allows you to display all counselors or just those in a specific area. There are 
several ways to assign your counselors to areas: 

 
(1) Highlight the name(s) of the counselor(s), highlight the area, and click the Assign button. 
 
(2) Highlight the names of one or more counselors and then double-click the desired area. 
 
(3) Highlight the desired area and double-click the names of the associated counselors. 
 

7.4 Define Areas   
 

If you have a large number of counselors, you may want to divide them into areas, either 
geographically or by badge type. Areas you define here will be available for selection on the 
individual MBC data entry dialog. When you assign a counselor to an area, you can 
optionally designate the counselor as the “Area Representative.” Names of counselors who 
have been designated as area representatives will be displayed on this dialog next to their 
associated area names. 
 
To create a new area, enter the area name and click Add. To change the name of an area or 
assign a new area representative, highlight the area name and click Edit. The “Area Rep” 
drop-down list on the Edit MBC Area dialog will let you select from a list of counselors who 
are assigned to that area. 
 
To delete an area, highlight the area name and click Remove. If any counselors are assigned 
to the area, the assignment will also be removed from their records. 

 
7.5 District Representative   
 

Use this dialog to designate a primary point of contact for your MBCs. You can manually 
enter a representative or select someone from your counselor database. Your entries will be 
printed at the top of MBC list reports. 

.  
7.6 Modify Merit Badges  
 

This dialog lets you update your merit badge list to keep it in synch with BSA changes. If 
BSA releases a new badge, click Add Badge and enter the new badge on the next dialog. If 
you’re not sure which number to assign to the new badge, please visit the “Announcements” 
page on the Troopmaster Software web site. 
 
To modify an existing badge, highlight the badge and click Edit. You can then change the 
badge name or mark it as “Outdated”. Outdated badges cannot be removed from the system 
but ADMS will add a “#” suffix. Eagle-required badges are flagged with an asterisk. 
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7.7 Delete/Archive Using Filter   
 

Because you sometimes need to delete an entire group of counselors, this dialog is provided 
so that you don’t have to delete them one-at-a-time. For example, after you have recertified 
counselors who have renewed their commitment, you could use this dialog to delete the 
counselors who did not. This is accomplished using the standard MBC filter selection dialog 
described in paragraph 2.10c. To continue this example, you would enter the new 
certification date in the certification “To” field on the filter, and ADMS will delete all 
counselors whose last recertification date is earlier than that. 
 
When you have entered your filter selection options, click OK and the next dialog will ask 
you for an effective date and whether or not you want to move deleted counselors to your 
archive. The effective date is saved in the archived records and used on three reports: the 
Detailed List, the Counselors Grouped by Badge, and the Deleted (Archived) Counselors 
reports. These reports all give you the option of including a list of counselors who have been 
deleted since a specified date. 
 
Before deleting/archiving any counselors, ADMS will display a confirmation dialog. The 
number of counselors you are about to delete is displayed on the confirmation dialog to help 
you ensure that you set the filter selections correctly. 

 
7.8 Retrieve from Archive  
 

Use this option to retrieve a counselor who had previously been deleted from your active 
database. After you specify a path to your archive, ADMS will present a list of archived 
counselors from which to select. See  paragraph 13.4 for information on retrieving counselors 
from the archive. 

 
7.9 Transfer Counselor Files  
 

Some districts designate a single leader, often the district advancement chair, to manage the 
district’s merit badge counselors. This option is used to send the counselor data files to the 
MBC manager so that they can be maintained separately from the rest of the ADMS 
database. The option is also used by the MBC manager to send the updated data files back so 
that they can be loaded into the main ADMS database. You can either email the counselor 
data files or save the data to a diskette, a formatted CD, or a hard drive folder. 

 
7.10 Receive Counselor Files  
 

This option is used to load a set of updated counselor data files received from the MBC 
manager back into the main ADMS database. This option is also used by the MBC manager 
to load a set of counselor transfer files sent to him from the main system. In either case, the 
files must have been created through the “transfer” option described in the preceding 
paragraph.  

 
Counselor data loaded through the “receive” function will replace any existing counselor data 
in the database. The received data will not be merged with existing counselor data. 
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CHAPTER 8. POINTS OF CONTACT 
 
8.0 Overview 
 

This area provides a powerful tool for tracking information on people who are important 
contacts for your district but who are not necessarily adult members. For example, you could 
use it to track council leaders, business contacts, religious leaders, etc. 
 

8.1 POC Management.   
 

Use this dialog to add new POCs to your database and to edit/review data on existing POCs. 
The Add New and Edit/Review buttons access the same data entry dialog. Most data fields 
are self-explanatory, but the “Category” and “Skills/Interests” fields provide special 
flexibility on reports.  

 
Because the types of people entered as POCs are frequently diverse, it is helpful to be able to 
group them into categories. You can define up to 20 different categories on the Define POC 
Categories dialog (see below). Then, when you add a new POC, simply assign him to a 
category from the drop-down list. The POC List report includes options to select a specific 
category or to group your POCs by category.  

 
The “Skills/Interests” fields are designed to handle more specific POC attributes. For 
example, you might use one of the fields to track business contacts who are willing to supply 
equipment that could be used at summer camp. You can enter up to four skills/interests for 
each POC. The POC List report includes options to search for POCs with specific 
skills/interests.  

 
To remove a POC, click Delete on either the POC Management or the POC data entry 
dialog. You will be asked to confirm the request before the POC is actually deleted. 

 
To review POCs assigned to a specific category, select the category on the POC 
Management dialog before clicking Edit/Review. The Next/Previous buttons will then take 
you to the next/previous POC in that same category. 
 

8.2 Define Categories.   
 

You can make your reports more flexible and useful if you group your POCs into categories. 
For instance, you could create categories for council leaders, business contacts, religious 
leaders, etc. Then, when you add new POCs to your database, you can assign them to 
appropriate categories. 
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CHAPTER 9. ACTIVITIES 
 
9.0 Overview 
 

ADMS will track attendance of your adult leaders at roundtables, camporees, committee 
meetings, Pow Wows, summer camps, Webelos camps, and up to 24 user-defined activity 
types. Activities can be entered in advance (this allows you to produce a district calendar) or 
you can enter the activity and attendance at the same time. There is a Generate Schedule 
dialog to help you create activity records for recurring events, such as Roundtables. 

 
9.1 Activity Management  
 

The Activities Management dialog is your primary gateway to scheduled activities. To enter 
new activities, click the Add New button or, if you need to create a set of records for 
recurring activities, click the Generate Schedule button (see para. 9.4). To review or credit 
attendance for an existing activity, double-click the desired activity or highlight it and click 
Edit/Review. 

 
If you select a specific activity type before clicking Edit/Review, then the Previous/Next 
buttons on the Edit/Review Activity dialog will let you “page” through the activities of the 
selected type. 

 
a. Add New Activity. Standard items include activity type, date, start time, amount, (e.g., 

nights camped), location, and remarks. The “Activity Type” field provides a drop-down 
menu of types you defined on the Define Activity Types dialog. Click the Define Types 
button to access this dialog. If you’d prefer to omit this activity from your district 
calendar, uncheck the “Include on calendar” box. 

 
The Generate Schedule dialog (see para. 9.4) lets you automatically create a schedule of 
weekly/monthly activities (such as roundtables) and add these to your activities file. 
 
b. Edit/Review Activities. This option is most often used to mark attendance but it also 

enables you to review or change any previous entries. Note that in Edit/Review mode, 
you can move to the next or previous activity via the buttons provided. 

 
c.  Marking Attendance. Attendance is credited by checking the box next to each attendee’s 

name. To make it easier to locate the attendees within a large database of adult leaders, 
the “Display” drop-down list lets you narrow down the list of names. For example, you 
can select leaders based on unit type or you can choose the “Filtered Selection” option 
(see para. 2.10a). To quickly see a list of those who have been marked as attending, check 
the “Display Only Adults Attending” checkbox. 

 
Before the activity takes place, you could check the names of all the adults who plan to 
attend. This would be useful in preparing a list of unit contacts (see following paragraph) so 
that you could, for example, mail or email information to the units in advance. 
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d. Unit Contacts. If units are involved in the activity and you will need to contact those units 
before or after the event takes place, click the Unit Contacts button. The resulting dialog 
enables you to designate a contact person for each unit participating. You can control the 
list of units through the drop-down list at the top of the dialog. For example, you can list 
units of a specific type or you can select the “Filtered Selection” option (see para. 2.10e). 
If you check the “Display only units attending” checkbox, ADMS will examine the list of 
adults who have been checked on the main Activity dialog and list just the units with 
which those adults are affiliated.  

 
For each unit, you can select a contact from a pop-up list. First, highlight the unit(s) for 
which you want to assign contacts. By default, if no units are selected, ADMS 
automatically highlights all of the listed units for you. Next, click the Select Contact 
button. You then have several selection options: 
 

(1) Select Contact For. You can elect to choose contacts for all of the highlighted 
units or you can narrow the selection dialogs to just those units which 
currently have no designated contact person. 

 
(2) Select Contact From. You have three options for controlling who appears on 

the selection dialogs. If you want to use the default contact person for each 
unit (see the Unit Details dialog), select the first option and ADMS will 
automatically assign the default unit contact as the contact person for this 
activity (no selection dialog will be presented). If you choose the “All adults” 
option, each unit selection dialog will list all of the adults in that unit. If you 
choose the “Adults attending” option, ADMS will limit each selection dialog 
to just the adults who have been marked as attending (you can also elect to 
include the default unit contact on each list, whether or not s/he will be 
attending). 

 
When you click OK, ADMS will display a contact selection dialog for the first selected 
unit. If the default unit contact is included, s/he will be marked with an asterisk. You can 
select the desired contact by double-clicking the name or by highlighting the name and 
clicking Select. ADMS will then display a list for the next unit, continuing until all of the 
selected units have been displayed. 

 
ADMS will not display a selection dialog for a unit if only one adult qualifies. For example, 
if you select the “Adults attending” option and only one adult with that unit is attending, 
ADMS will automatically make that adult the activity contact without displaying a selection 
dialog. For the same reason, selection dialogs are never displayed if you select the “Default 
unit contact” option 

 
Buttons at the bottom of the Unit Contacts dialog allow you to generate a set of mailing 
labels for all of the contact or to send each of them an email message. 

 
If you choose the “Email” option and check “Display message prior to sending” on the Send 
Email dialog, you can use your default email program to add an attachment to the messages. 
This is an easy and inexpensive way to distribute information packets. 
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9.2 Define Activity Types  
 

ADMS tracks adult attendance at up to 30 different types of activities. Some of the more 
common types are pre-defined by the system. You can define other types to meet the specific 
needs of your district. For each new type, enter a name (which must be unique) and, if 
desired, a field label to be used for the activity “amount” field. Then, click Add. 
 
To change the name of an existing type, highlight it and click Edit. ADMS will 
automatically apply the change to pre-existing activities of that type. To delete a type, 
highlight it and click Remove. System-defined types cannot be removed or modified. 

 
 
9.3 Delete Activities  
 

ADMS will track up to 1000 activities. When the file is full, you can use this option to delete 
old activities by date range and by selected type(s).  
 

9.4 Generate Schedule  
 

This option makes it easy to create a schedule of recurring activities and add those to your 
activities file. For example, let’s suppose you want to create a schedule of monthly 
Roundtables. Select type “RndTable” from the drop-down list. Then, check “Include on 
calendar” since you definitely want your Roundtables on your district calendar. Then, enter 
the date of the first scheduled Roundtable in the “From” field and the date of the last 
Roundtable in the “To” field. Select the “Monthly” option and make any appropriate entries 
(such as “Location”) in the activity fields. Lastly, click Add and ADMS will automatically 
create a full schedule of Roundtables based on the weekday of the first Roundtable date, and 
it will display the generated dates in the list box. 

 
Before saving these to your activities file, check the list for holidays, etc. For example, if 
there will be no meeting during Christmas week, highlight that date and click Remove. If 
you need to add another date to the list, use the “Add single date” option. When all of the 
dates in the list are correct, click Save and ADMS will add all of the scheduled Roundtables 
to your activities file.  
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CHAPTER 10. TRAINING 
 
10.0 Overview 
 

This area makes it easy to schedule training courses and then credit attendees with course 
completion. There’s also a group credit function you can use to credit adults with training for 
which you have not created a training schedule. A Define Training dialog lets you manage 
your training course list as courses are added or changed. 

 
10.1 Training Management  
 

Use this dialog to add new training schedules to your database and to edit/review data on 
existing schedules. The Add New and Edit/Review buttons access the same data entry 
dialog. 
 
To schedule a new course, click Add New. On the Schedule New Course dialog, select the 
desired course from the drop-down list. If the “Contact” for the course is one of your district 
leaders, you can select that person from the drop-down list; otherwise, manually enter the 
name, phone and email address. Then, enter the date, time, and location for the course. If the 
course has more than one session (see para. 10.3), you can specify a separate date, time, and 
location for each session. Lastly, enter the instructor name(s) and any desired remarks.  
 
If you have a list of planned attendees, you can check their names in the list box provided. If 
the course has more than one session, you can use the “Scheduled adults for” drop-down list 
to record separate attendance for each session.  
 
To make it easier to locate the attendees within a large database of adult leaders, the 
“Display” drop-down list lets you narrow down the list of names. For example, you can 
select leaders based on unit type or you can choose the “Filtered Selection” option (see para. 
2.10a). To quickly see a list of those who have been marked as attending, check “Display 
Only Adults Attending.” To erase all attendance markers for a session, click Clear 
Attendance. 

 
When the course is complete, highlight the course on the Training Management dialog, click 
Edit/Review, and mark attendance or adjust the attendee list, as necessary. Then, click the 
Credit Training button to credit the training records for selected attendees. If the course 
consisted of multiple sessions and a course attendee missed one or more sessions, the course 
will be added to that adult’s “Partial Training” record. 

 
If the same or mostly the same adults attended or will attend all sessions, mark the attendees 
once and then use the Copy Attendance button to mark the same attendees on all of the 
sessions. 

 
When you credit training, ADMS will offer to generate a training completion report that 
includes signature blocks. Just sign the report and submit it to your council office. 

 
The Previous/Next buttons let you “page” through your scheduled courses.  
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10.2 Group Credit  
 

To credit a group of adults for completion of the same course for which you have no training 
schedule, select the attendees and the course, enter a completion date, and click Process.  

 
When you credit training, ADMS will offer to generate a training completion report that 
includes signature blocks. Just sign the report and submit it to your council office. 

 
10.3 Define Training  
 

This dialog lets you manage your training course list. To add a new course, enter a course 
name, a course code (which must be unique), the number of sessions, and a training 
expiration period (in years). Then, click Add.  
 
To modify an existing course, highlight the course name and click Edit. Make any needed 
changes in the pop-window and then click OK. 

 
Although BSA has not published training expiration periods for any of their courses, many of 
the local councils have done so for certain courses. Expiration periods you enter here will be 
used by the software to determine which adults need retraining. 

 
To delete a course, highlight it and click Remove. 
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CHAPTER 11. UNITS 
 
11.0 Overview 
 

This area allows you to track detailed information on your units and on the scouts and adults 
associated with each unit. You can also make unit commissioner assignments and setup each 
unit for a new Scouting year. 

 
11.1 Unit Management  
 

The Unit Management dialog is your gateway to all the detailed information on any given 
unit as well as to details on the scouts and adult leaders associated with the unit. The “Unit 
Type” drop-down list lets you control which units are listed in the corresponding “Select 
Unit” list.  You can select a specific unit type, such as “Troops”, or you can use the “Filtered 
Selection” option to refine the list (see para. 2.10e). 

 
a. Unit Details. Clicking the Add Unit or Unit Details button takes you to the same 

four-tab data entry dialog.  
 

(1) General Info. The “General Info” tab has basic information on the unit type as 
well as address and phone number data for contacting the unit and chartering 
organization. A unit “Descriptor” field is provided in case you need to add 
descriptive text to help differentiate your units. For example, many New England 
troops have the same number so you could use the descriptor to differentiate 
“Troop 1 – Auburn” from “Troop 1 – Benton.”  
 
If the unit is LDS, check the associated checkbox. There is a drop-down list for 
you to assign a unit commissioner (see also para. 11.2). If this is a “Special 
Needs” unit, select the type and then click the Description button to provide 
details. If the unit has a web site, there is a field to enter that as well as a Website 
button that will take you to it.  

 
It’s especially important that you select a default contact person for the unit as 
that is used in several other areas of the program. If you’ve entered an email 
address, just click the Email button to send them a message.  

 
(2) Membership/Participation. The “Membership/Participation” tab has fields where 

you can enter monthly membership numbers for the current calendar year. There 
are also checkboxes where you can indicate for each month whether the unit 
submitted an advancement report, attended Roundtable, or participated in a pack 
or troop campout.  

 
ADMS will automatically check the appropriate “Roundtable” box for you if you credit one 
of this unit’s leaders for attending a Roundtable in the “Activities” area of the program. 

 
When you’re ready to start a new membership year, click the Setup 
Membership/ Participation for 20xx button and ADMS will clear all existing 
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entries on this tab and copy the starting/ending membership figures to the unit 
“History” tab.  

 
There’s a Unit > Setup New Year menu option that will accomplish this for all of your units 
with a single request.  

 
(3) Visits. This tab lets you track date, visitor, and remarks for up to 10 visitations by 

the unit commissioner. To delete a visit, click the X next to it and ADMS will 
erase that entry and move all lower visits up. 

 
(4) History. The “History” tab lets you track a variety of items for the unit over a 10 

year history, such as beginning/ending membership numbers and Boy’s Life 
figures. Five of the items can be user-defined. These have been predefined by the 
system for such things as “Summer Camp” (troops) and “Camp” (packs), but you 
can redefine any of these by clicking on the label and entering a new label. You 
can define separate items for packs versus the rest of your units.  

 
Fundraiser fields at the bottom let you track results for popcorn sales and the 
family/unit Friends of Scouting drive. Figures entered for the current FOS 
campaign will be totaled and shown in the FOS area of the program (see para. 
6.1) as well as on FOS reports. There are also two unit popcorn sales reports. 

 
The View Boy Scout Advancement History button takes you to another dialog 
where you can view or enter advancement summary information for scouts in the 
unit below the rank of Eagle (ADMS does not include Eagle Palms in 
advancement summary reports). All of the entries on this dialog for any given 
year will be automatically calculated by ADMS if you import data from 
TroopMaster (see para. 11.1c) or if you manually enter advancement for the 
scouts into this system. “Non-Eagle Scouts” is the total number of scouts in the 
unit below Eagle at the end of the year. “Total Advancement” is the total number 
of rank advancement (Tenderfoot through Eagle) for all scouts in the unit during 
that year. There are also entries that show the average time in months that it takes 
a scout in this unit to advance to 1st Class, Star, Life, or Eagle (see Appendix B). 

 
ADMS only calculates advancement figures on this dialog for the current Scouting year. 
Because scouts come and go, figures for prior years cannot be calculated by the system, but 
you can make manual changes, if needed.  

 
The Setup History for 20xx button clears the data for the oldest year and makes 
room for the new year.  

 
There’s a Unit>Setup New Year menu option that will accomplish this for all of your units 
with a single request.  

 
b. Delete Unit. Click this button to delete a unit which has folded. This will completely 

erase the unit and all scouts associated with the unit. In addition, any adults associated 
with the unit will be deleted and archived except for adults who are also district 
leaders or who are also associated with one or more other units. 
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c. Import. You can import data from units using our TroopMaster, TroopLedger, and 
PackMaster, and PackLedger programs (Millennium versions or newer). This 
includes personal data, advancement information, and FOS campaign results. If the 
unit is not yet in your database, you must add it first. Then, select the desired unit 
from the drop-down list, and click Import.  

 
(1) Unit Data from TroopMaster/PackMaster. Both programs have a 

File>Export> District Program Files option for this purpose. The Import Unit 
dialog gives you complete control over which data is imported. For example, you 
could import just the scout personal data and advancement but skip the adult data. 
If you import adults, you can decide which area(s) of the adults’ records to 
import. For example, you could choose to import adult special awards, leadership 
history, and O/A, but skip their training courses. ADMS will list the names of the 
scouts and adults in the transfer file so that you can see who you’re importing. If 
you choose to import unit general information (i.e., address, phones, chartered 
organization, etc.), you can also elect to update the membership figures and 
camping checkboxes on the “Membership/Participation” tab of the Unit Details 
dialog. If the file is created properly, the file name will look like “Troop xxx 
Transfer.xfr.” 

 
 If you have already imported or plan to import unit data from a ScoutNET “Trained” 
or “Not Trained” file, then you may want to skip the adult leader data (or at least the 
adult training) in the TroopMaster/PackMaster transfer files. The data in the 
ScoutNET files of course matches the data in ScoutNET whereas the unit data may not. 
TroopMaster/PackMaster may also include adults who are not in the ScoutNET 
database, especially if you don’t select the “Registered adults only” option. 

 
If you import adults, ADMS will automatically delete/archive adults currently in your 
database who are no longer with this unit unless the adult is also a district leader or is also 
associated with another unit. Existing adults will be updated and new adults added. 

 
TroopMaster also has a File>Export>District Program files>MB Counselors option to 
transfer counselor data into ADMS. Please see para. 3.7b(2) for import procedures. 

 
(2) Unit FOS Totals from TroopLedger/PackLedger. Both programs have a 

File>Transfer option for this purpose. The Import Unit Friends of Scouting 
dialog will display the current FOS data that you have for this unit versus the FOS 
data in the transfer file and let you choose which year(s) to import. If the file is 
created properly, the file name will look like “Troop xxx FOS Transfer.xfr”. 

 
(3) Leaders/Training from ScoutNET. Please see para. 3.7c(2). 

 
d. Adults. If “Adults” are selected, the Unit Management dialog will list the names of 

the adults in the selected unit. You can highlight the desired adult and then access any 
area of that adult’s data, as described in the “Adults” area (see Chapter 5) of this 
manual. In other words, ADMS provides two methods of reviewing the same data on 
the adults associated with one or more units. The only difference is that the “Adults” 
main menu option also lets you access district leaders. 
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e. Scouts. Click the “Scouts” radio button and the Unit Management dialog will list the 
names of the scouts in the selected unit. You can highlight the desired scout and then 
use the buttons to access separate dialogs for that scout’s personal data, advancement, 
leadership, and O/A. 

 
If the unit uses TroopMaster or PackMaster, the data for all four scout dialogs can be 
imported from the unit data transfer file (see para. 11.1c(1)). The TroopMaster Millennium 
transfer file does not contain Varsity award data for the “Advancement” dialog, but that will 
be added in the next major version of TroopMaster. 

 
(1) Personal Data. This dialog has two tabs. The first tab has fields for basic data such 

as the scout’s name, date of birth (DOB), social security number (SSN), school 
grade, and parent data. In addition to fields for household address, there’s an 
“Alternate” address section in case the parents are divorced or separated.  

 
Collecting SSN’s raises Privacy Act issues. You should consult an attorney before doing 
this. 

 
The second tab is for “Advancement.” This tab can be accessed directly through 
the Advancement button on the Unit Management dialog, so it’s described in the 
following paragraph. Buttons at the bottom of the dialog let you access the scout’s 
“Leadership” and “O/A” dialogs, or to page to the next or previous scout. 

 
(2) Advancement. ADMS tracks completion of the rank badges for each level of 

Scouting (Cub Scouts, Boy Scouts, Venturing, etc.). There is also an area to track 
merit badges and completion dates.  When the scout comes up for the Eagle rank, 
the “Advancement” dialog has a Validate Eagle button that will review his rank 
dates, merit badges, and Life rank leadership positions and advise you whether or 
not the scout meets all of the requirements for Eagle. For a complete description 
of the “Validate Eagle” function, please see paragraph 4.4. 
 
If you cannot or choose not to import this data, any of the items can be input 
manually. To add a merit badge, select the desired badge from the drop-down list, 
click Add, and enter the completion date in the pop-up dialog. To delete a merit 
badge, highlight it and click Remove. 

 
(3) Leadership. This dialog tracks the scout’s leadership history as well as up to two 

current leadership positions. To add a new position, select it from the drop-down 
list and enter the appropriate date(s). For the first current position and for all of 
the positions in the “History” list, you can indicate whether the position should be 
counted toward the “Position of Responsibility” requirement on the Validate 
Eagle dialog (see para. 4.4). ADMS will set the default based on the list of 
creditable leadership positions in the Boy Scout Handbook. If you need to assign 
the scout to a position that is not on the menu, click the Define Positions button 
and add it. You can assign two current leadership positions to each scout. To 
remove a scout from a previously entered position, select the blank position from 
the drop-down list and enter the date he vacated the position. 
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When a scout changes leadership positions, the vacated position is automatically moved to 
his leadership history list. The “Effective Date” of the new position is used as the closeout 
date of the old position.  

 
(4) O/A. If the scout is an O/A member, make the appropriate entries here. All of the 

data items are self-explanatory. 
 
11.2 Unit Commissioners  
 

The Unit Commissioners dialog helps you review and manage your unit commissioner 
assignments. The “Commissioner” drop-down box will list all of the adults who have been 
assigned a leadership position of “Unit Commissioner”. The list also contains an 
“Unassigned Units” option (the default) so that it’s easy to see which units don’t have a 
commissioner. There are two ways to assign units to commissioners. 
 

a. Unassigned Units. Select this option from the drop-down list. Then, check the units 
that you want to assign to a specific commissioner. Lastly, click the Select 
Commissioner button and choose the desired commissioner from the pop-up dialog. 

 
b. By Commissioner. Select a commissioner down the drop-down list. If you want to see 

just the units to which this commissioner is assigned, check the “Display Only 
Assigned Units” checkbox. Otherwise, ADMS will display a list of all units in the 
database, including units assigned to other commissioners. The ones to which this 
commissioner is already assigned will be checked. Adjust the assignment checkboxes 
as desired and click OK. 

 
11.3 Setup New Year  
 

This dialog makes it easy to setup all of your units for the new Scouting year without having 
to display them one at a time. It affects the “Membership/Participation” and/or the “History” 
tabs of the Unit Details dialogs for your units. 
 

a. Unit Membership/Participation. If you check this box, ADMS will clear all existing 
entries on the “Membership/Participation” tab for each unit and optionally copy the 
starting/ending membership figures to the unit’s “History” tab. 

 
b. Unit History. This option clears the data for the oldest year on each unit’s “History” 

tab and makes room for the new year 
 

If you’ve already setup a new year on either of these tabs for one or more of your units, 
ADMS will not erase or modify any existing entries for those units. Only those units which 
do not yet have the new year will be affected. 

 
This “Setup” option is unrelated to the “Setup” new year option in the FOS area.  
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CHAPTER 12. REPORTS 
 
12.0 Overview 
 

All system reports are included under this menu option. The reports are divided into 11 
functional groups, each of which is described below. All reports are initially displayed on the 
screen. Because “a picture is worth a thousand words,” only a brief description of each report 
is provided below. 
 
Most reports have several and often many different generation options. For example, the 
Friends of Scouting Unit Summary has options to include units with no donations or unit 
totals only. The report also has four different sort options. 
 
For each report, select the desired options and click OK. Displayed reports can be printed, 
emailed, or saved to a disk file.  
 
See File>Preferences (see para. 3.13) for information on adjusting your page settings, 
mailing labels settings, fonts, colors, display scrolling, etc. 

 
To help protect sensitive data items such as SSNs, ADMS has a “Protected Fields” feature 
that allows you to block certain data items from appearing on displays and/or reports (see 
para. 3.13f).  

 
All reports are initially displayed on the screen and the display is very flexible. For example, 
there’s a drop-down list at the top of the display dialog that allows you to zoom in or out on a 
report (you can also do this through the left/right mouse buttons).  You can also elect to 
display two pages at the same time. The left/right arrow buttons on the dialog allow you to 
page the report, or you can use the Page Up/Down buttons on your keyboard. Other buttons 
let you jump to the first or last page of the report. 
 
A tools button lets you modify the format settings for the report currently being displayed 
(you can permanently change the settings through File>Preferences).  Other buttons allow 
you to print the report, email it, or save it to disk. If you elect to save the report to a disk file, 
the report is generated and written to a file you specify using any of three optional formats:  

 
(1) Web Page (*.html) - select this format if you want to be able to review the report with 

your web browser. Most reports will display in your browser almost identically to the 
way they appeared in ADMS. However, matrix-style reports will lose their vertical and 
horizontal line separators. 

 
(2) Rich Text (*.rtf) - Select this option if you plan to review and/or edit the report with a 

word processor. Most reports will display in your word processor almost identically to 
the way they appeared in ADMS. However, matrix-style reports will lose their vertical 
and horizontal line separators. 

 
(3) Text (*.txt) - Select this option if you plan to review the report with a simple text editor, 

such as Windows Notepad. Reports saved in plain text will lose most of their formatting; 
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i.e., special fonts, point sizes, bold column headers, etc., will be dropped. Just the text 
itself will be saved to the file. 

 
ADMS remembers your current working folder and will use it as the default, but you can 
change that if you wish, and you can use any name you like for the report file.  
 
Several reports (e.g., Leader Training Matrix, Unit History Matrix) are produced in a 
spreadsheet format with column headers at the top of the report. The default settings will 
print the column headers vertically to make them easier to read. However, if you are saving 
your report to disk or emailing it, you will need to specify the “Horizontal” table headers 
option when producing these reports. HTML, Rich Text, and plain text do not support 
vertical text. 

 
If you choose to email a report, ADMS will create a new message and attach the report in 
any of the three optional formats (i.e., Web Page, Rich Text, or Text) described above. It will 
then bring up the Send Email dialog (see para. 3.5) so that you can select the recipients 
before sending it. 

 
You can easily email an entire set of individual member reports, one message/report per 
member. For example, you could generate a set of Individual Personal Data reports on your 
MBCs and then email them to the counselors using almost the same procedure you use for 
sending a single report. However, in this case, when ADMS brings up the Send Email dialog, 
each of the selected counselors will already be listed in the “To” list box, and you will not be 
able to change this recipient list. When you click Send, ADMS will automatically create a 
separate message for each counselor and attach that counselor’s report to his individual 
message. Then, all of the individual messages will be added to your “Outbox”. Since in this 
case there are multiple messages, the “Display message prior to sending” checkbox is 
deactivated. Therefore, if you want to add or change the text of the message itself, you must 
do that on the Send Email dialog before clicking Send. This feature provides an easy and 
inexpensive way to have your counselors to review the data you have on each of them to 
ensure that it is current. 

 
12.1 Activities 
 

This menu group includes all of the reports related to your district’s activities, including 
roundtables, committee meetings, camporees, and user-defined activity types. 

 
Activity reports can be generated with or without specifying a date range. If no dates are 
specified, all activities of the selected type(s) will be included on the report. If only a “From” 
date is entered, activities on or after that date will be included. If only a “To” date is entered, 
activities on or before the “To” date will be included. Most of the reports will include 
attendance information for either adults or units. If you choose the “units” option, ADMS 
determines attendance based on the unit affiliation of the adults who attended. 

 
a. Individual Activity Report. Select one or more activities and ADMS will generate a 

separate report for each selected activity containing all information on that activity, 
including adult or unit attendance. 
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b. Activities by Type. This report provides detailed tracking of a specific activity type. It 
lists all of the activities of the requested type for the specified time period and then 
optionally includes attendance matrices for units or adults. 

 
If you request an attendance matrix, the report is limited to a maximum of 63 activities. 
On the matrix, the date of each activity is listed vertically at the top of each column. The 
total attendance for each activity is listed vertically at the bottom of each column. 
Individual unit or adult totals are shown on the right-hand side of the report. 

 
c. Activities List. This report chronologically lists all district activities (calendar and non-

calendar) for the specified type(s) and time period. Optionally, you can include the 
activity “Remarks”.  

 
d. Attendance Matrix. This report serves two purposes: (1) a data collection form to record 

attendance at activities, and/or (2) a report for viewing previously recorded attendance at 
activities. You can generate the report for units or selected adults and optionally limit the 
report to calendar activities. 

 
If you select more than one activity type on this report, selecting the “Include activity 
type” option will make the report more meaningful. You can choose to print the entire 
name of each type or just the first or first four characters of the name. 

 
e. Calendar. This report includes all of your scheduled calendar activities for the specified 

type(s) and time period. This report can be generated either as a list-type report with 
activities grouped by month, or in a one-page-per-month, “wall-calendar” format. 

 
f. Participation Summary. This is actually a group of six reports, three on your units and 

three on your adults. You can select amount totals, attendance ratios, or attendance 
percentages on one or more activity types. For each adult/unit, ADMS will print two 
figures (separated by a slash) for each of the selected type(s). The first figure is the total 
number of activities of that type that the unit/adult attended. The meaning of the second 
figure varies based on the report option you chose: 

 
(1) Amount Totals. The second figure is the total number of nights camped, miles hiked, 

etc., for that activity type. For activities like meetings, the amount is usually zero. 
 
(2) Attendance Ratios. The second figure is the total number of activities of that type that 

the scout/adult could have attended. For example, it might show that an adult attended 
9 of 12 meetings. 

 
(3) Attendance Percentages. The second figure is the first figure divided by the total 

number of activities of that type that the scout/adult could have attended, expressed as 
a percentage.  

 
Unless you select the “ratios” option, you can optionally include an activity summary. If 
you select “Amount Totals,” the summary will show the total number of activities of each 
type and the total amount (e.g., 6 camps/12 nights) for the district (not the participants). If 
you select the “Percentages” option, the summary will show the total number of activities 
for each type and the average attendance percentage for your units/adults. 
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12.2 Adult Members 
 

Except for attendance and training reports, most of the reports specific to your adult leaders 
are in this area. All of the reports give you the option of limiting the adults included based on 
unit type or “Filtered Selection” (see para. 2.10a). 

 
a. Individual Personal Data. This report lists all of the personal data on a selected adult(s). It 

also includes leadership positions, special awards earned, training completed, and O/A. 
 
b. ADC/Unit Commissioners. This report has several options. You can get a list of your 

Assistant District Commissioners (ADCs) and under each ADC, the report will list Unit 
Commissioners and, optionally, associated units. You could also limit the report to a 
specific Unit Commissioner with associated units. Another option lets you get a list of 
units which have no Unit Commissioner assignment. 

 
c. Email List. This report produces a list of email addresses selected adult leaders. If a 

leader is associated with one or more units, those are also listed. 
 

d. General Purpose Matrix. This option produces a spreadsheet-type report similar to the 
General Purpose Worksheet but allowing many more columns. You can define up to 65 
column headers for this report, making it very useful for creating a checklist of items for 
selected adults. Just assign the report a title and then define as many column headers as 
you like. For each column, enter the header text and click Add. If you need to adjust the 
sequence, highlight the header that you need to relocate and click Move Up or Move 
Down. If you want to have columns with no predefined headers, increase the “Number of 
columns” field to the total number needed. 

 
If you think you might use the same matrix again, click the Save button and assign it a 
file name. Then, the next time you need the matrix, just select it from the drop-down list. 
If there’s a saved matrix that you no longer need, select it from the list and click Delete. 

 
e. General Purpose Worksheet. This extremely flexible worksheet can be used for a 

multitude of purposes. For example, you could use it as a data collection worksheet by 
giving it a title and defining one or more column headers. Optionally, you can choose to 
include selected items from the adults data file, such as date of birth or BSA ID number.  

 
If you think you might use the same worksheet again, click the Save button and assign it 
a file name. Then, the next time you need the worksheet, just select it from the drop-
down list. If there’s a saved worksheet that you no longer need, select it from the list and 
click Delete. 

 
f. Having/Needing Awards/Training. This is a group of four reports that provide lists of 

adults who either have or need a specific training course or special award. First, select the 
main option desired (e.g., “Needing training course”). Then, choose the desired course or 
award name from the menu, or enter the name in the “Other” field. For training reports, 
several other options are available. 
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(1) Having Training. If you request this option, you can elect to list only adults who 
completed the training on a specific date. This could be very helpful if the course 
roster has been misplaced. 

 
(2) Needing Training. This will generate a list of adults who have not taken a selected 

course but you can optionally include adults who need retraining. If you’ve 
defined a course expiration period (see para. 10.3) for the selected course, ADMS 
will pre-fill the “Earlier than” date field based on the period you specified. You 
can also manually enter a date. Either way, the report will include adults who last 
completed the course earlier than the date specified. If any of the adults have 
already been scheduled for retraining, the scheduled training date (see para. 10.1) 
will be included on the report.  

 
Optionally, you can elect to contact all of the adults listed on the report either by 
email or by generating a set of mailing labels. When you close the report, ADMS 
will make the requested option (i.e., email or labels) available. 
 

g. Leadership Experience. This report lists selected adults and their current leadership 
positions. Usually, you will also want to include each adult’s leadership history and total 
service years. Another option lets you list adults with no leadership experience. 

 
h. Phone List. This report lists your adults' names, mailing addresses, phone numbers, unit 

affiliation(s), and leadership positions. Email addresses can optionally be included. 
 

i. Service Years. This report shows the service years status of your adults based on an “as 
of” date you specify. ADMS computes the service years for each adult based on current 
leadership position(s) and effective date(s) plus any prior leadership history. The report 
also shows the date when each leader will complete another year of service. 

 
j. User Defined Fields/Remarks. This option provides a powerful way of producing special 

reports on your adults. ADMS lets you select any or all of the user-defined fields from 
the adult personal data display (see para. 5.1a(3)). The report then lists each of your 
adults and the selected data item(s). 

 
Use this option to produce reports that are not otherwise available. For example, you could 
label one of the text fields as “Hobbies” and then print a “Leader Hobbies” report. 
 
k. Custom Report. This option allows you to create custom reports on your adults by 
choosing specific data fields to include on the report. For example, you may wish to generate 
a one-line-per-adult phone list, including each adult’s name, home phone, cell phone, and 
email address. Or you can turn it into a two-line report and add items like BSA ID number, 
date of birth, occupation and college degree. In addition to selecting which data fields to 
include, you can specify a report title. 

 
If you think you might use the same report again, click the Save button and assign it a file 
name. Then, the next time you need the report, just select it from the drop-down list. If 
there’s a saved report that you no longer need, select it from the list and click Delete. 
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12.3 Friends of Scouting 
 

These reports are designed to help you manage and review the results of your FOS campaign. 
Donation information for the Family/Unit division is obtained from the “History” tab of the 
Unit Details dialog. Donation information for all of the other divisions is obtained by 
examining records for the friends in your database and grouping the results by division. 

 
a. Individual Personal Data. This report lists all of the personal data on a selected friend(s). 

The report also includes donation history. 
 
b. FOS Campaign Information. This report allows you to print the data from the Campaign 

Information dialog (see para. 6.1). The two sections can be obtained separately or 
together, and they correspond to the two tabs on the dialog. The first section contains the 
data from the first tab of the dialog, including campaign division, kick-off date, goal, etc. 
The second section contains campaign results from the “Campaign History” tab.  

 
c. FOS Comparison. On this report, you can elect to include any or all of the divisions 

defined on the Campaign Information dialog. For each selected division, the report 
compares donation results for the past three years. The “% Change” columns are 
calculated by dividing the figure on the right by the figure on the left and expressing the 
result as a percentage. If you select the “Family/Unit” division, you can optionally 
include donation results for each of your units, grouped by unit type. 

 
d. FOS List. Use this report to generate a list of your friends, grouped by campaign division. 

In addition to personal data, you can elect to include email address, employer, and total 
donations. If you select the “Totals Only” option, the report will omit data on specific 
friends and instead just include totals by division for the past three years. 

 
e. FOS Unit Summary. This report shows the results of the Family/Unit donations listed by 

unit. The dialog provides four different sorting options for the data, which is all taken 
from the “History” tab on the Unit Details dialog.  For each unit, the report includes the 
following items. 
 
(1) Average # Scouts.  Computed by averaging the “Beginning” and “Ending” scout 
membership figures for the current campaign year. 
 
(2) # Donors. Figure is taken directly from the “History” tab. 
 
(3) Percent Participation. Computed by dividing the number of donors by the average 
number of scouts. 
 
(4) Average Donation. Computed by dividing the total donations by the number of 
donors. 
 
(5) Total Amount. Figure is taken directly from the “History” tab. 

 
Optionally, you can omit the unit details altogether by selecting the “Include totals only” 
option. The report then contains FOS subtotals, grouped by unit type, plus district grand 
totals. 
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12.4 Mailing Labels/Envelopes 
 

You can print mailing labels or envelopes for adults, FOS, MBCs, POCs, and scouts. Scout 
labels are available in six different formats. You can also print custom mailing labels as well 
as district return address labels. The default address for the return address labels is taken 
from the district General Information dialog but you can change that, if needed. All of the 
label options allow you to specify a starting point for sheet labels so that you don’t have to 
waste partial sheets. Except for scouts, you can optionally sort the labels/envelopes by zip 
code. 

 
You can adjust label alignment via the Page Settings tab on the File>Preferences dialog. 
You can also change the label format (the system default is Avery 5160). 

 
The default return address for envelopes is taken from the district General Information dialog 

 
When printing envelopes, in addition to setting the envelope size within ADMS, you must 
also use your printer Properties dialog to set the envelope size and print orientation for your 
printer itself.  There’s a button for this on the ADMS Print dialog. 

 
When printing scout labels, you can print labels for all scouts or selected scouts within a 
given unit. Optionally, you can include labels for alternate relatives. 

 
Custom labels enable you to print labels for special mailings. You specify the name/address 
to be printed and the number of copies. For example, you could use this feature to print 
personal return address labels for your Christmas cards! 

 
12.5 Merit Badge Counselors 
 

Reports in this group help you manage and more effectively utilize your MB counselors. 
Please note that there is an MBC training report on the Reports>Training menu (see para. 
12.8h). 
 
a. Individual Personal Data. This is a single counselor report that includes all of the data on 

a selected counselor, including the badges s/he teaches. Optionally, you can append a 
footnote in case you want to mail the reports to your counselors for review and update. 
To facilitate that, other options allow you to format the reports for window envelopes and 
to sort them by zip code. 

 
 An easier and less expensive method would be to create the reports and then click the 

Email button. After choosing a format, select the “Send separate messages” option, 
ADMS will then create a separate message for each counselor, attach his report to the 
message, and put all of the messages into your “Outbox.” 

 
b. Counselor Phone List. This report is just a simple phone list of your counselors. 
 



 54

c. Cross Reference. This report consists of two parts. The first is a numbered, alphabetical 
list of your counselors that optionally includes addresses, phone numbers and/or email 
addresses. The second is an alphabetical list of merit badges with the corresponding 
numbers of the counselors who teach them. The two listings together provide a cross-
reference for locating counselors for any specific merit badge. This report provides the 
same information as the “Grouped by Badge” report below, but it requires less paper. 

 
d. Detailed Listing. This report can be used to list all of the data on each of your counselors, 

including the badges they teach. However, checkboxes allow you to exclude selected data 
items, if desired. 

 
e. Grouped by Badge. This is the easiest report for locating a counselor for a specific merit 

badge. Badges are listed alphabetically with the counselors’ names, addresses, phone 
numbers and email addresses under each badge. Checkboxes allow you to exclude 
selected data items, if desired. 

 
 In addition to a full report, there is also an option to produce an “Addendum” report, 

which is described in the following paragraph. 
 
f. Grouped by Badge Addendum. This menu option will take you to the same dialog as the 

standard one used for “Grouped by Badge” report. This report is listed as a separate menu 
option simply to help you locate it more easily.  The “Addendum” report contains just 
those counselors who have been newly certified since a date you specify. If desired, the 
“Addendum” report can also include a list of counselors who have been dropped since the 
same date. 

 
g. Specific Merit Badge. For this report, you specify a badge and ADMS lists all of the 

counselors who teach it. Optionally, you can include street addresses, mailing addresses, 
and all phone numbers (versus just the home phone). 

 
h.  Area Summary. This report provides a list of the areas you have defined along with the 

names and phone numbers of the area representatives 
 
i.  Counselors With No Merit Badge. Use this report to get a list of counselors who have no 

merit badges assigned to them. 
 
j.  Deleted (Archived) Counselors. Use this report to get a list of counselors who have been 

archived since a date you specify. 
 
k.  Merit Badge List. This report is simply a list of all of the merit badges in your system. 

You can list them alphabetically or by badge number. 
 
l.  Merit Badges w/No Counselor. This report lists the badges for which you have no 

counselor. Outdated badges are automatically excluded. 
 
m. Uncertified Counselors. This report makes it easy to see which counselors have not been 

certified. Optionally, you can include counselors who need to be recertified; i.e., 
counselors whose “Recertification” date is earlier than a date you specify. 
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12.6 Order of the Arrow 
 

This menu group includes all of your O/A reports. 
 

a. O/A Membership. The report lists O/A members and for each member includes dates for 
O/A Election, Ordeal, Brotherhood, and Vigil, as well as O/A leadership positions and 
remarks. As an option, you can list all recently elected scouts and adults who have not yet 
completed their Ordeal. You can run this report for all of your adult leaders or you can 
request a membership report (scouts and adults) for a specific unit. 

 
b. Adult Individual Member. This report includes all of the data from the O/A member 

dialog for the selected adult. 
 
c. Scout Individual Member. This report includes all of the data from the O/A member 

dialog for the selected scout. You can select from a scout membership list for any unit. 
 
12.7 Points of Contact Reports 
 

There are two reports available on your POCs. 
 

a. Individual Personal Data. This report includes all of the data from the POC dialog for the 
selected individual(s). 

 
b. POC List. You can list information on your POCs alphabetically, grouped by category, or 

for a specific category. POCs can be sorted by name or position. If you use the “Filtered 
Selection” option (see para. 2.10d), you can search for specific skills or interests and have 
ADMS look for a match on any or all of your entries. POC remarks can optionally be 
included. 

 
The POC skills/interests search looks for matches based on full or partial entries made on this 
dialog. For example, if you enter “Tra”, ADMS would match POCs whose “interests” 
include “Transportation” or “Training.” 

 
12.8 Training 
 

All training-related reports for your adult leaders are in this area. There is also a training 
report for merit badge counselors. 
 
a. Individual Scheduled Course. Select the desired course and ADMS will generate a report 

containing all of the information from the Scheduled Course dialog, including date, 
location, contact person, instructors, remarks, and a list of scheduled attendees. If the 
course has more than one session, you can elect to include data on any or all of the 
sessions. 

 
b. Scheduled Training List. This report provides a list of scheduled courses for any time 

frame. If you don’t enter “From-To” dates, all scheduled courses are included. If you 
only enter a “From” date, all courses on or after that date are included. If you only enter a 
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“To” date, all courses on or prior to that date are included. For each course, the report 
shows all of the information from the Scheduled Course dialog except the attendee list. 

 
c. Adults Having/Needing Awards/Training. This menu option provides an alternative way 

of generating the same report available on the Reports>Adult Members menu. Since 
most of the report options are training-related, it’s included again on this menu for 
convenient access. Report usage is described in paragraph 12.2f. 

 
d. Adult Partial Training. This report makes it easy to review adults who have completed 

some but not all sessions of courses that have more than one session. You can group the 
report by adult or by training course. Since you may not know which adults have partial 
training entries, all of the adults are highlighted by default; however, only adults with 
partial training are included on the report. 

 
e. Adult Training Completion. This option enables you to create a “Training Completion” 

report to submit to your council office for any completed training course. This is the same 
report that ADMS offers to generate when you credit training from the Scheduled 
Training dialog (see para. 10.1). Select the desired course and then enter a “From-To” 
period. If you know the exact date of the course, enter that date in both the “From” and 
“To” fields. If the course was conducted more than once during the specified time period, 
all attendees will be included on a single report. 

 
f. Adult Training List. This report will list all of the selected adult(s) and for each adult, it 

lists the training courses completed and the associated completion dates. It also shows the 
leadership position code(s) for each adult 

 
g. Adult Training Matrix. This option generates a spreadsheet report of selected adults along 

with the completion status for each of the selected training courses. The report also shows 
the units with which each adult is affiliated and for each unit, it shows the adult’s 
leadership position and the number of years served in that position. This report makes it 
easy to see which adults need specific training courses. Training completion is marked 
with an “X”. If an adult’s training has expired (see para. 10.3), the course is marked with 
a pound sign (“#”). If an adult is currently scheduled to take a course, the course is 
marked with an asterisk. 

 
h. MB Counselor Training Status. This report lists your MBCs and shows the status of each 

counselor with respect to Youth Protection Training (YPT) and the MBC Orientation 
course. Optionally, you can include counselors who have completed both courses. 
Another option allows you to include counselors whose YPT completion date is earlier 
than a date you specify.  

 
i. Top Leader Training Status. This report groups your units by type and for each unit it 

shows whether the top leader (i.e., cubmaster, scoutmaster, etc.) is fully trained. If so, the 
unit is marked with a “T”. Optionally, you can show if the top leader is partially trained; 
those will be marked with a “P”. The overall percentage of top leaders trained is shown at 
the top of the report. 

 
j. Unit Training Details. This option generates a separate report for each selected unit. For 

each unit, it lists the adults associated with that unit, along with their leadership positions 
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and effective dates. For each adult, the report shows training status with respect to the 
training courses required to be fully trained based for the position(s) held. A legend at the 
bottom explains the meaning of the training status codes. If a leader is scheduled to attend 
one of the courses, the scheduled date is shown in parentheses under the appropriate 
column. The report also shows the percentage of the unit adults who are trained and the 
percentage partially trained. ADMS will also flag adults who need to complete Youth 
Protection Training. 

 
k. Unit Training Summary. This option provides a spreadsheet-type report grouped by unit 

type. For each unit, the report summarizes the training status of the unit leadership. For 
the top leader (i.e., cubmaster, scoutmaster, etc.) and for the committee chair, the report 
will mark the leaders as “T” (trained), “P” (partially trained), or “F” (Fast Start). For 
other leader groups (e.g., assistant scoutmasters/cubmasters, den leaders, committee 
members, etc.), the report shows you the total number of leaders in that group, and the 
numbers that are trained, partially trained, or untrained. For example, the report might 
show that the unit has six committee members of which three are trained, one is partially 
trained, and two are untrained. For each unit, the report also shows the percentage of unit 
leaders who are fully trained. At the end of each unit type, ADMS shows the percentage 
of all leaders in that group who are trained (e.g., number of leaders trained/total number 
of leaders). 

 
12.9 Unit 
 

This group includes a wide variety of reports, including rosters, phone lists, membership 
reports, advancement reports, popcorn sales and general information reports. 
 
a. Individual Scout Data. This report lists all of the personal data on a selected scout, along 

with an advancement summary. If the scout is an OA member, that data is also included.  
 
b. Individual Unit Details. This report contains all of the data from the Unit Details dialog 

for a selected unit. There are four sections: general information, membership, unit visits, 
and history. Each of these can be selectively included through option checkboxes. 

 
c. Unit Roster. Select this option to get a roster report for a specific unit(s). The report 

includes the unit leaders along with mailing addresses, phone numbers, email addresses, 
and leadership positions. Optionally, you can also include the scouts in that unit. 

 
d. Charter Status. This report is great way to see which units are coming up for recharter. In 

addition to being able to tailor the list of units based on unit type or “Filtered Selection” 
(see para. 2.10e), you can request units whose charter expiration date falls within a 
specified “From-To” period. Optionally, you can include units whose charter has expired 
regardless of the specified “From-To” period and/or units which have no expiration date 
in their records. The report is grouped by unit type and for each unit includes a contact 
person. 

 
e. ADC/Unit Commissioners.  This report lists your Assistant District Commissioners, Unit 

Commissioners and, optionally, associated units. This same report is available on the 
Reports/Adult Members menu but since it’s also unit-related, it’s included again here. 
Please see paragraph 12.2b for a more complete description.. 



 58

 
f. History Matrix. This report allows you to review all of the data from the “History” tab of 

the Unit Details dialog for selected units in a spreadsheet format. By default, the report 
uses the current year but you can select any year desired. If you include more than one 
unit type, the report is grouped by type. Data items include starting/ending membership 
figures, Boy’s Life, leader trained, popcorn/FOS results, etc. 
 

g. Membership History. This report allows you to compare membership figures for selected 
units in a columnar format. The report is grouped by unit type. For each unit, the report 
compares membership figures for the past four years. The “Net Change” columns are 
calculated by dividing the figure on the right by the figure on the left and expressing the 
result as a percentage. A summary is provided for each unit type that shows membership 
subtotals and net change percentages.  

 
If you select the “Include totals only” option, unit details are omitted and the report just 
contains unit type subtotals and district grand totals. 

 
h. Membership/Participation Matrix. This report allows you to review any or all of the data 

from the “Membership/Participation” tab of the Unit Details dialog for selected units in a 
spreadsheet format. If you include more than one unit type, the report is grouped by type. 
The report optionally includes monthly membership figures, advancement report 
submissions, roundtable attendance, and campout records.  

 
If membership figures are included, the report includes end of year change percentages, 
computed by dividing the last month membership figures by the first month figures; unit 
subtotals are shown at the bottom of each section 
 
If you select the “District totals only” option, the report omits unit details and contains 
only the subtotals for each unit type plus district grand totals. 

 
i. Quality Unit List. This report lists all of the units that attained “Quality Unit” status based 

on the corresponding checkbox on the “History” tab of the Unit Details dialogs for the 
specified year. 

 
j. Visitation Summary. This report provides a very flexible way of reviewing the last visit 

for selected units and seeing when the next visits are scheduled. You can review units 
regardless of unit commissioner assignment or you can limit the report to just those units 
assigned to a particular commissioner. The “Unit Types” drop-down list lets you further 
refine which units are included. 

 
You can then request a list of the most recent and next scheduled visits regardless of date, 
or you can limit the report based on a specified “From-To” period, or you can limit the 
report to visits since a specified date. If you specify a “From-To” period or a “Since” 
date, the report will include the most recent and next scheduled visit for each unit based 
on the date restrictions specified; i.e., the report will not include all of the previous/next 
visitations within the specified time period. 
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Other options allow you to sort the report by unit, by last visitation date, or by next 
scheduled visit date. If you decide to include remarks, you can choose to include either 
the last visit remarks or the next visit remarks. 

 
k. Advancement Details. The report makes it easy to review the advancement progress of 

your units for any desired time period. If you don’t enter “From-To” dates, all 
advancement is included. On the report, units are grouped by unit type and subtotals are 
printed for each type. For each unit, the report lists total scouts, the total number of rank 
advancements for the specified time period, and a breakdown of those advancements by 
rank.  For troops and crews, it also shows the total number of merit badges earned by 
scouts in each unit.  For crews, the report also shows the total number of Venturing 
awards earned and a breakdown by award type. For teams, the report just contains 
summary information on the Varsity Letter and Denali Award. 

 
 If you check the “Include totals only” box, unit details are omitted and the report just 

contains the award subtotals for each unit type. 
  
l. Merit Badges Earned. This report will show you the relative popularity of the different 

merit badges. If desired, you can specify a time period or if you leave the “From-To” 
dates blank, data on all badges will be tabulated. The report shows you the number of 
times each merit badge was earned. The badges can be sorted alphabetically or by the 
number of times each badge was earned. 

 
m. Unit Boy Scout Advancement Summary.  The first two columnar sections compare 

advancement results for the specified year versus the prior year. There are two main 
options. 

 
(1) Actual Figures. For each unit and each year, the report shows the number of scouts in 

the troop below the rank of Eagle, the total number of rank advancements, and the 
average number of rank advancements per month. 

 
(2) Percentages. For each unit and each year, the report shows the number of scouts in the 

troop below the rank of Eagle, the percentage of those scouts who advanced, and the 
average percentage per month. This option is better for comparing your troops against 
one another because it eliminates troop size as a factor. 

 
Data used in computing the above figures are normally obtained from the unit’s 
Advancement History dialog. You can view this data by bringing up the Unit Details 
dialog, going to the “History” tab, and clicking the View Boy Scout Advancement 
History button (see para. 11.1a(4)). However, if either the “Non-Eagle Scouts” or “Total 
Advancement” fields are empty on that dialog for the specified year, ADMS will go 
through the individual records for the scouts and use their advancement data. 
 
The last columnar section shows the average time in months it takes in each unit for a 
scout to advance to 1stClass, Star, Life, and Eagle. Again, ADMS uses figures from each 
unit’s Advancement History dialog if figures are available. Otherwise, ADMS will go 
through the individual records for the scouts and use their advancement data in 
conjunction with the formula described in Appendix B.  
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n. Popcorn Comparison. For selected units, this report compares sales results for the past 
three years. The “% Change” columns are calculated by dividing the figure on the right 
by the figure on the left and expressing the result as a percentage. The units are grouped 
by unit type and subtotals are shown for each type. Figures used on this report are 
obtained from the “History” tab of the Unit Details dialogs. 

 
If you check the “Include totals only” box, unit details are omitted and the report just 
contains unit type subtotals and district grand totals. 

 
o. Popcorn Sales Summary. This report uses figures from the “History” tab of the Unit 

Details dialogs to produce summary sales figures for the specified year. For each unit, the 
report shows the average number of scouts (based on beginning and ending membership 
figures), total sales, and average sales (total sales divided by the average number of 
scouts). Data on the report can be sorted by unit, total amount, or average sales. The 
report includes subtotals for each unit type. 

 
If you check the “Include totals only” box, unit details are omitted and the report just 
contains unit type subtotals and district grand totals. 

 
12.10 Forms 
 

To help you gather data on your adult leaders, friends of Scouting, merit badge counselors, 
and point of contact, there are separate personal data collection forms on each group. 

 
12.11 Other 
 

This is a group of miscellaneous lists of system and user definitions.  
 
a. Adult Definitions Lists. This report has separate lists of adult leadership positions, special 

awards, training courses, and categories. The lists include both user-defined and system-
defined items. 

 
b. Member Group List. This report lets you get a printed copy of any member groups you 

have created through the District>Group Members option (see para. 4.3). You can select 
the desired group(s) and then choose which type(s) of members (i.e., adult leaders, FOS, 
MBCs, POCs) to include on the report. 

 
c. Merit Badge List. This option generates a list of merit badges in the system. It can be 

printed alphabetically or by badge number. 
 

d. POC Category List. This option generates a list of POC categories you’ve defined. 
 

e. Scout Leadership Positions. Use this option to obtain a list of scout leadership positions. 
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CHAPTER 13. ARCHIVING 
 
13.0 Overview 
 

ADMS provides an archive for adult leaders and MBCs who leave your district. The archive 
data is completely separate from your active district data, but an adult or counselor can be 
retrieved from the archive if s/he later returns to your district. 

 
13.1 Creating an Archive 
 

We recommend keeping the archive on a hard drive but you can use a zip drive, if desired. 
An archive is initially created for you as a subfolder under the main program folder (e.g., 
C:\Program Files\ADMS\Archive). Up to 10,000 adult leaders and 5000 MBCs can be stored 
in a single archive. If the initial archive fills up, create another via the File>Create New 
Archive option. 

 
13.2 Archiving Adults/MBCs 
 

To archive an adult or MBC, highlight the member on the associated management dialog or 
display the member’s personal data dialog. Then, click Delete/Archive, check the “Archive” 
option on the pop-up dialog, and enter the date the member left your district. If you click 
OK, ADMS will archive the selected member and then delete him from your active district 
files.  

 
Archiving a member saves all of the member’s data except adult leader attendance at district 
activities. For adult leaders, the current leadership position(s), if any, will be closed out and 
moved to the leadership history area.  

 
13.3 Reviewing Your Archive 
 

To review your archive or print reports on archived adults and MBCs, select the File>Open 
Archive Files option. ADMS remembers where your archive was last accessed and will 
present that path as the default. To remind you that you are in the archive, the words 
“Archive Files” will be displayed on the title bar. While in the archive, some options (e.g., 
activities, POCs, FOS, etc) are not available. However, you can add or review archived 
adults and MBCs, edit data entries, print reports, etc. 

 
Adults who left your district before you purchased ADMS can be added directly to the 
archive via the “Add New” member options. 

 
13.4 Retrieving Members from an Archive 
 

If you need to retrieve an archived adult or MBC back into your active database, go to the 
Adults or Counselors pull-down menu and select Retrieve from Archive. Enter the path to 
your archive (the default is the path to the archive you most recently accessed), and click 
OK. Select the name of the member you want to retrieve and click Retrieve. 
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CHAPTER 14. MAKING BACKUPS 
 
14.0 Overview 
 

It is hard to overstate the importance of making backups. Maintaining your active database 
and archive requires a lot of work. Protect that work by following the procedures in this 
chapter carefully. 

 
ADMS uses file compression technology for backups. Your active database or archive will 
be compressed into a single, much smaller file. Don’t be alarmed at the speed of the backup 
and the relatively small size of the backup file. You will not be able to read this file with any 
of your other programs, nor will you be able to decompress it with any other program 

 
14.1 Backing Up Your Active Database 
 

Your district data represents a major investment of your time. It is extremely important that 
you make frequent backups of this data. Don't let a hard drive failure force you to rebuild 
your data from scratch. We recommend making a backup after each data entry session (don't 
wait until you get your whole database built before you make your first backup!). In addition, 
don’t always backup to the same backup diskette or folder. If your hard drive becomes 
corrupted, it is possible to damage your primary database and the backup before you 
recognize the problem. Also, if you need to restore from a diskette and your only backup 
diskette is damaged, you’ll be up the proverbial creek. 

 
Because of this, we recommend that you maintain at least three backups. Alternate between 
these backup folders or diskettes each time you backup your data files. By alternating, you 
greatly increase your chances of being able to recover from a damaged file. 
 
Whenever you exit the program, ADMS will give you the option of automatically backing up 
your active unit data. You can also request a backup through the File>Backup Data Files 
option. Only small districts can be backed up to a diskette. If your backup does not fit on a 
single diskette, you’ll need to backup to a different medium, such as a CD, zip cartridge, or 
hard drive folder. 

 
ADMS can only backup to a CD if it’s been formatted for data. Because CDs can be used for 
a variety of purposes, CDs do not come pre-formatted but your CD drive will have come 
with a program that that has a format function. 

 
14.2 Backing Up Your Archive 
 

To backup your archive, select File>Backup Data Files, click the “Archive Files” radio 
button, and click OK. As long as space allows, you can backup your archive to the same 
location(s) you use for your active district data. 
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APPENDIX A. SYSTEM LIMITATIONS 
 

ADMS will not let you exceed the following limits: 
 

- 10,000 adult leaders 
- 25 leadership history positions per adult 
- 100 special awards per adult 
- 100 training courses per adult 
- 10 partial training courses per adult 
- 5000 merit badge counselors 
- 500 points of contact 
- 30 unit activity types 
- 1000 total activities 
- 500 units 
- 250 scouts per unit 
- 15 leadership history positions per scout 
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APPENDIX B. AVERAGE TIME TO RANK FORMULA 
 

For each Boy Scout troop in the system, ADMS will calculate the average amount of time it 
takes for a scout in that unit to advance from Scout to 1st Class, Star, Life, and Eagle. This 
appendix covers the formula used in these calculations.  
 
This “average time to advance” is calculated in two areas: 
 

(1) Advancement History Dialog. When you setup a new year on the Unit Details dialog, 
ADMS will go through the available advancement data for the unit and compute the 
average time it takes for a scout in that unit to reach each of these ranks. It then saves 
the results on this dialog when it adds a column for the old year. Data entries for 
earlier years are not affected. 

 
(2) Troop Advancement History Report. When this report is generated, ADMS attempts 

to obtain “Average Time to Rank” figures for the selected year from the Advancement 
History dialog. If no figures are available, it then goes through the available 
advancement data for the unit and computes these averages.  
 

For each rank, ADMS first examines all scouts who have earned the rank and computes the 
average time it took them to do that (i.e., the “Base Average”). Then, it considers all scouts 
who have been scouts longer than the Base Average but who have not yet earned the rank.  
This time will be used to increase the average time for that unit via the following formulas: 

 
    Base Average = (DF / NF)  
 
    Average time to rank for the unit = ((DF + DS) / (NF + NE)) 
 
Where: 
 
DF = total days it took all scouts who have earned the rank to earn it 
 
DS = total days since joining Boy Scouts for scouts who are below the rank and 
whose service time exceeds the Base Average 
 
NF = number of scouts who have earned the rank 
 
NE = Number of scouts who are below the rank and whose service time exceeds the 
Base Average 
 
The computed unit average is expressed on the report in months: 

 
(Average time in days x 12)/365 

. 
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APPENDIX C. TECHNICAL SUPPORT 
 

Virtually everything you need to know about using ADMS is readily available without your 
having to contact us. We recommend the following approach: 

 
(1) First, consult the on-line help. Every dialog has a Help button that will display the 

section of the manual applicable to the dialog being displayed. Also, the main menu has a 
Help option that gives you access to the on-line help through several different avenues, 
including an index “search” feature. 

 
(2) Consult the User Manual. To see it, start ADMS and select Help/View User Manual 

(requires Acrobat Reader 3.0 or newer). In addition to standard text descriptions of the 
program features and usage, the User Manual also has “Tutorial” links to animated demos 
that take you through selected features step-by-step. The demos can be viewed through a 
tutorial menu and also from links in the corresponding sections of the manual. 

 
(3) Visit the “Frequently Asked Questions” (FAQs) page on our web site. There is a separate 

FAQs page for ADMS. 
 

If you still cannot find the answer you need, contact us directly. While we cannot accept 
collect phone calls, we are available to answer questions at 434-589-6788 (Mon-Fri 9AM-
5PM EST). Simple questions can also be handled by using the “Tech Support” form on our 
web site (www.troopmaster.com). Detailed questions require that you call us. If necessary, 
we can also be available after normal office hours on an appointment basis. 
 
Replacement CDs outside of the warranty period are $10. 

 
We have always tried to provide the very best technical support available, completely free to 
our users. However, the advent of email threatens our ability to continue doing that. For 
many of the email questions we get, the answer is easily available through the on-line help or 
the User Manual. Please help us keep our user support free by not contacting us directly 
unless you cannot find the answer you need. 

http://www.troopmaster.com/faq/faq_misc.html
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APPENDIX D. DATA IMPORT OPTIONS 
 

In addition to importing data from ASCII delimited files, ADMS also enables you to import 
data from export files created by ScoutNET, TroopMaster, PackMaster, TroopLedger and 
PackLedger. Data can be imported into four main areas of ADMS: adult leaders, scouts, 
merit badge counselors, and unit data.  
 
To help you understand what you can expect from the export files, this appendix provides 
charts showing the data items contained in each type of file. There is a separate chart for each 
of the four areas. Each chart lists the ADMS data items that can be imported from each type 
of export file.  
 
We recommend that you start by getting the “Training Completed” and “Training Not 
Completed” export files from ScoutNET and importing those. This will import all of the 
registered adult leaders for all of the units in your district, and it will also create a unit record 
for each unit. You should repeat this process periodically to bring in new adult leaders and to 
update the data on existing leaders.  
 
If your district has been using our MBCounselors program, the best way to build your MBC 
data would be to obtain a copy of MBCounselors backup data and import from that. If not, 
you should get each of your troops that use TroopMaster Millennium (or newer) to create an 
export file (File > Export > ADMS > MBCounselors) and import each of those files. 
 
To import personal and advancement data on scouts, ask each of your units that are using 
TroopMaster or PackMaster to create a unit export file (File > Export >  ADMS > Unit 
Information) and import each of those files. Doing this will also import more unit data as 
well as (optionally) more data on adult leaders with that unit. 
 
To import Friends of Scouting data (i.e., total FOS donations and the number of donors), you 
can ask units using our TroopLedger and PackLedger programs to export that data. The 
export file is created through the “File > Transfer > ADMS” option in Troop/PackLedger. 
 
For specific procedures on importing each type of file, please see sections 3.7 and 11.1c of 
this manual. 
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Import Options for Adult Leader Data 
 
 

 
ScoutNET 

Ldrs/Training 
ScoutNET 

Ldrs/Scouts Unit Data from 
Adult Data Items All Units Single Unit TroopMaster/PackMaster

    
Last X X X 
First X X X 
Initial X X X 
Suffix X X X 
BSA ID# X  X 
Nickname X X X 
Sex X X X 
DOB  X X 
Spouse   X 
Mailing Address X X X 
City X X X 
State X X X 
Zip X X X 
Country X X X 
Phone Numbers X X X 
Email   X 
SSN  X X 
Employer   X 
Occupation   X 
Occupation Type    
University    
Degree    
Religion    
Eagle Date   X 
Categories    
Remarks/Other    
Adult Special Awards   X 
Training X  X 
Leadership/Units X X X 
O/A   X 
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Import Options for Merit Badge Counselors Data 
 
 

 
ScoutNET 

Ldrs/Training MBC's from MBC's from 
MBC Data Items All Units MBCounselors TroopMaster 

    
Last X X X 
First X X X 
Nickname X   
Sex X X  
BSA ID# X X X 
Address X X X 
City X X X 
State X X X 
Zip X X X 
Country X X X 
Phone Numbers X X X 
Email  X X 
Badges Instructed  X X 
Area  X  
Units  X X 
DOB  X  
SSN    
Original Certification    
Recertification  X  
Date Last Taught  X  
MB Counselor 
Orientation    
Youth Protection 
Training    
Remarks    
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Import Options for Scout Data 
 
 

 
ScoutNET 

Leaders/Scouts Unit Data from 
Scout Data Items Single Unit TroopMaster/PackMaster 

   
Last X X 
First X X 
Nickname X X 
Initial X X 
Suffix X X 
BSA ID#  X 
DOB X X 
Sex X X 
Grade X X 
SSN X X 
Address X X 
City X X 
State X X 
Zip X X 
Country X X 
Phone Numbers X X 
Email  X 
Relatives  X 
Alt Relative  X 
Alt Address  X 
Alt Phone  X 
Alt Email  X 
Advancement  X 
Leadership  X 
O/A  X 
Training   

 



 70

Import Options for Unit Data 
 
 

 
ScoutNET 

Ldrs/Training 
ScoutNET 

Ldrs/Scouts Unit Data from 
Unit FOS Data 

from 
Unit Data Items All Units Single Unit Troop/PackMaster Troop/PackLedger 

     
Unit Type X X   
LDS   X  
Number X X   
Descriptor     
Charter Expiration  X X  
Original Charter    X  
Unit Commissioner     
Special Needs  X X  
Website   X  
Unit Contact     
Mail Recipient   X  
Address1  X X  
Address2  X X  
City  X X  
State  X X  
Zip  X X  
Country  X X  
Email     
Meeting Place   X  
Address1   X  
Address2   X  
City   X  
State   X  
Zip   X  
Country   X  
Meeting Phone   X  
Chartering Org  X X  
Address1   X  
Address2   X  
City   X  
State   X  
Zip   X  
Country   X  
Chartered Org  Phone  X X  
Schools     
Remarks     
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Membership/Campout   X  
Visits     
FOS Donors    X 
FOS Dollars    X 
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